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Welcome to scanning 
with HP PrecisionScan Pro and your 
HP ScanJet scanner

The scanning software and your HP ScanJet scanner 
let you quickly create excellent electronic images from 
pictures and convert text on paper into editable text.

Features

Some of the features of the scanning software are:
■ Click to select an image in the preview
■ Automatic sensing of output type
■ Automatic sensing of optimal exposure, color, black 

and white threshold, sharpen level, and resolution 
for images of pictures

■ Drag-and-drop the image to another program or to 
the desktop

■ Scale and size the image prior to exporting it to a 
program or a file

■ Return to the preview image without rescanning
■ Tools for adjusting exposure, color, black and white 

threshold, sharpen level, and resolution
■ Save and re-use scanning settings
■ Use HP PrecisionScan Pro scanning software and your 

HP ScanJet scanner on a local area network
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Microsoft is a U.S. registered trademark of 
Microsoft Corporation.

Windows is a trademark of Microsoft 
Corporation.

Acrobat® Reader Copyright © 1987-1997 
Adobe Systems Incorporated. All rights 
reserved. 

Adobe and Acrobat are trademarks of Adobe 
Systems Incorporated, which may be 
registered in certain jurisdictions.

FlashPix (portions) Copyright © 1996
Book Contents Index
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➮

Support for your new product

No matter where you are or when 
you need it, HP support is there to 
help you get the most from your 
HP products. Whether it’s making 
products easier to use or providing 
you with innovative new ways to 
tackle your important projects, HP 
support helps you become a 
confident and creative user. If you 
do encounter a problem with your 
HP product, don’t worry. HP 
support delivers fast, accurate 
solutions that won’t rob you of 
either your product or your 
valuable time.

When you’re ready to get started, 
check out HP’s Web site,

http://www.scanjet.hp.com

for great ideas and quick tips on 
how to use your HP product in fun 
new ways.

© Hewlett-Packard Co., 1999. All Rights 
Reserved. Reproduction, adaptation, or 
translation without prior written permission 
is prohibited, except as allowed under the 
copyright laws.

RESTRICTED RIGHTS LEGEND
U.S. Government Restricted Rights. The 
Software and any accompanying 
documentation have been developed entirely 
at private expense. They are delivered and 
licensed as “commercial computer software” 
as defined in DFARS 252.227-7013 (Oct 1988), 
DFARS 252.211-7015 (May 1991) or DFARS 
252.227-7014 (Jun 1995), as a “commercial 
item” as defined in FAR 2.101(a), or as 
“Restricted computer software” as defined in 
FAR 52.227-19 (Jun 1987) (or any equivalent 
agency regulation or contract clause), 
whichever is applicable. You have only those 
rights provided for such Software and any 
accompanying documentation by the 
applicable FAR or DFARS clause or the HP 
standard software agreement for the product 
involved.

First Edition, 1998
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How to use this online document

Go to the book contents, chapter contents, or 
index

■ Click the button in the yellow bar at the bottom of the 
page when the pointer looks like .

Page forward one page

■ Press Enter or PgDn, 
– or –

■ Click  in the yellow bar at the bottom of the page.

Page backward one page

■ Press Shift+Enter or PgUp,
– or –

■ Click  in the yellow bar at the bottom of the page.

Jump to a different part of the document

■ Click when the pointer looks like .

Undo a jump

■ Click  in the toolbar, 
– or –

■ Right-click to display the dropdown Acrobat Reader 
menu, then select Go Back.

Re-do a jump

■ Click  in the 
– or –

■ Right-click to di
menu, then sele

➮

➮
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the scanner light turns on and 
he bed. The charge-couple device 
nner records a digital image of the 

rom the original you placed on the 
e recorded image is made up of 

 inch (ppi) and each pixel can have 
 36 bits.
age can potentially have millions 

ed for use in another program 
-and-drop it, save it as a file and 
r copy it, then paste it into an open 

i n g  w o r k s
Using the HP ScanJet 

scanner
Book Contents Index
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What can you scan?
Using the scanning software, you can scan:
■ color photographs
■ color drawings and line art
■ grayscale drawings
■ black and white photographs
■ black and white drawings and line art
■ pages that have both pictures and text

During a scan, 
moves across t
(CCD) in the sca
light reflected f
scanner bed. Th
1200 pixels per
a depth of up to
The resulting im
of colors.
An image is sav
when you drag
insert the file, o
document.

H o w  s c a n n
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e 
he 

er 

s straight edges, place the top and 
t to the top and right edges of the 
is will make the preview image 
ou scan.
Using the HP ScanJet 

scanner
Book Contents Index
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Place the picture on the scanner
The picture you want to scan must be placed face down 
on the scanner glass.

1 Lift the scanner lid 
and hold it up.

2 Place the pictur
face down on t
scanner glass.

3 Close the scann
lid.

If you are using the HP Automatic Document Feeder, 
see the online manual HP Automatic Document 
Feeder Guide.

A D F  u s e r s

If the picture ha
right edges nex
scanner bed. Th
straight when y

T I P
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 is below the lid on the front of the 

ows Start menu

 the Windows Start button.

tart menu appears.
menu, choose Programs, then choose 
ware:HP PrecisionScan Pro.

ing software window appears, the 
t automatically perform a Preview 

w scan:
eview button in the scanning software 
r, or

enu, select Preview, or

o use the HP ScanJet Button 

figure the Scan button to set 
Pro as the default software 

 the Scan button is pushed 
HUsing the HP ScanJet 

scanner
Book Contents Index
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Start the scanning software
There are three ways to start the scanning software:
■ push the Scan button on the scanner
■ use the Windows Start menu
■ launch the scanning software from another program 

using TWAIN (page 11)

Pushing the button on the scanner

1 Push the Scan button on the scanner once.

After the scanning software window appears, the 
scanner automatically performs a Preview scan and 
displays the preview image.

The Scan button
scanner.

Using the Wind

1 Select ,

The Windows S
2 From the Start 

HP ScanJet Soft

When the scann
scanner does no

scan. 
3 To start a Previe

■ click , the Pr
window toolba

■ from the Scan m
■ press Ctrl+R. 

Scan button

You may need t
Manager to con
HP PrecisionScan

to launch when
(see page 12).

T I P
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ustry-standard communications 
ding instructions to hardware 

ner) and receiving data back (such 
 you are using a program that 
, you can start HP PrecisionScan Pro 

at program. 
canners and HP scanning software 
IN, but the programs you use to 
ts may not be TWAIN-compatible.
can use TWAIN, it should have a 
med Acquire, Acquire Image, or 
 of its main menus, usually the File 

 of these commands launches the 
ware selected with the Select Source 

cannot be transferred using TWAIN.

A I N ?
HUsing the HP ScanJet 

scanner
Book Contents Index
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The scanner performs a Preview scan and displays 
the preview image.

Launching from another program

If you are creating a project such as a greeting card or a 
calendar, and want to include a picture from a 
photograph, you might be able to scan the photograph 
directly into the program you are using. To do this, the 
program must have a TWAIN command such as 
Acquire, which is probably on one of its main menus.
1 Open the program in which you will place the 

scanned image.
2 If necessary, select the program’s Select Source 

command and choose HP PrecisionScan Pro.
3 Select the program’s TWAIN command.

After the scanning software window appears, the 
scanner automatically performs a Preview scan and 
displays the preview image.

4 Create a selection area in the preview image, make 
necessary adjustments, and select Return to 

<application> from the Scan menu. The final scan 
occurs and the image is placed in the calling 
program.

TWAIN is an ind
protocol for sen
(such as a scan
as an image). If
supports TWAIN
directly from th
■ HP ScanJet s

can use TWA
create projec

■ If a program 
command na
Import on one
menu.

■ Selecting one
scanning soft
command.

■ Editable text 

W h a t  i s  T W
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 the Windows Start button.

tart menu appears.
menu, choose Programs, then choose 
ware:HP ScanJet 

Jet Button Manager.

Button Manager window appears.

om the Windows Control Panel, 
nners and Cameras. Select HP ScanJet 

et 6350C, or HP ScanJet 6390C from the 
if it is not already selected. Click the 
n. Click the Events tab.
 button from the Scanner events drop-

ionScan Pro in the list box.
Disable Events option is not checked.

Button Manager window closes.
HUsing the HP ScanJet 

scanner
Book Contents Index
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Configure the Scanner buttons
You can use the HP ScanJet Button Manager to configure 
the Scan  and Copy buttons. The Scan 
button is set at the factory to automatically launch the 
HP PrecisionScan Pro software. The Copy button is set at 
the factory to automatically lauch the HP ScanJet Copy 
utility. 

1 Select ,

The Windows S
2 From the Start 

HP ScanJet Soft

Utilities:HP Scan

The HP ScanJet 

Windows 98: Fr
double-click Sca

6300C, HP SCanJ

drop-down list 
Properties butto

3 Select the Scan

down list.
4 Check HP Precis

5 Make sure the 
6 Click OK.

The HP ScanJet 

Scan button
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Scanner Buttons

The scanner button settings available to you are 
optimized for a specific type of application. They are 
designed to be a fast and efficient way to get your scan 
to a fax, e-mail program, or a document management 
application.

E-mail 
button

Fax 
button

Document 

Management button
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To scan to an e-mail application:

1 Push the E-mail button on the scanner.
2 The Scanner Button Settings dialog appears.
3 Select an E-mail application in the Scan To 

drop-down list. Only supported e-mail applications 
installed on your PC appear in the list.

4 Adjust the Scanner Settings as necessary.
• An Output Resolution of 75 dpi will produce a 

smaller file size for an e-mail attachment and look 
good on screen.

• If Auto crop is checked, only the image placed on 
the scanner bed will be sent to the e-mail 
application. If Auto crop is unchecked, the entire 
scanner bed will be sent as the image.

Note: If you check the Do not show the scanner settings 

again option, the Scanner Button Settings dialog will 
not appear each time you push the E-Mail button on 
the scanner. To re-open the Scanner Button Settings 

Dialog, select the Start menu, choose Programs then 
choose HP ScanJet Software:HP ScanJet 

Utilities:Scanner Button Settings.
5 Click OK.
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To scan to a fax application:

1 Push the Fax button on the scanner.
2 The Scanner Button Settings dialog appears.
3 Select a Fax application in the Scan To drop-down 

list. Only supported Fax applications installed on 
your PC appear in the list.

4 Adjust the Scanner Settings as necessary.

Note: If you check the Do not show the scanner settings 

again option, the Scanner Button Settings dialog will 
not appear each time you push the Fax button on the 
scanner. To re-open the Scanner Button Settings 

Dialog, select the Start menu, choose Programs then 
choose HP ScanJet Software:HP ScanJet 

Utilities:Scanner Button Settings.
5 Click OK.
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To scan to a document management application:

1 Push the Document Management button on the 
scanner.

2 The Scanner Button Settings dialog box appears.
3 Select a Document Management application from 

the Scan To drop-down list. Only supported 
document management applications installed on 
your PC appear in the list.

4 Adjust the Scanner Settings as necessary.

Note: If you check the Do not show the scanner settings 

again option, the Scanner Button Settings dialog will 
not appear each time you push the Document 

Management button on the scanner. To re-open the 
Scanner Button Settings Dialog, select the Start menu, 
choose Programs then choose HP ScanJet Software:HP 

ScanJet Utilities:Scanner Button Settings.
5 Click OK.
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 window showing a Preview scan
HA tour of the scanning 

software
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➮

Scanning software window
This chapter describes the scanning software.
➊ Menus — The commands in the menus are 

summarized beginning on page 19.
➋ Toolbar — The toolbar has buttons for the most 

commonly used commands (see page 24).
➌ Preview area — The scanned image appears in the 

preview area of the scanning software window (see 
page 25).

➍  Info bar — Displays width and height of the output 
image, scale percentage, the Output Type currently 
selected, and Help button (see page 26).

➎ Status bar — Displays messages and approximate 
size of the selection area (Image Size) (see page 27).

Image adjustment tools — The scanning software has six 
tools for making adjustments to the image. These 
tools can be placed anywhere on the Windows 
desktop (see page 30).

Online Help — Help includes topics, What’s This, more 
online manuals, and videos (see page 41).

➊ Menu bar
➋ Toolbar

➌ Preview

➎ Status bar

area

Scanning software

➍ Info bar
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 resolution and displays the 

a (see page 63).
selection area and saves the image 

a scan to an application (see 

 the TWAIN-compatible program 

 a set of scanning settings (see 

 a set of saved scanning settings 

ection area and sends the image to 

tions for printing.
log box for setting preferences for 
HA tour of the scanning 

software
Book Contents Index
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Menus

All the commands for the scanning software are 
available in the menus. Each menu and its commands 
are described in the following tables.

Preview Ctrl+R Scans the entire area of the scanner glass at low
preview image (see page 57).

Zoom Scans and enlarges the view of the selection are
Save As... Ctrl+S Displays the Save As dialog box, then scans the 

to a file (see page 109).
Scan To... Displays the Destination dialog box for sending 

page 105).
Return to <application> Scans the selection area and sends the image to

that called it (see page 11).
Save Settings... Displays the Save Settings dialog box for saving

page 44).
Load Settings... Displays the Load Settings dialog box for loading

(see page 46).
Print... Ctrl+P Displays the Print dialog box, then scans the sel

the printer (see page 104).
Print Setup... Displays the Print Setup dialog box for setting op
Preferences... Displays the HP PrecisionScan Pro Preferences dia

the scanning software (see page 47).
Exit Closes the scanning software.

S c a n
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s it to the Clipboard for pasting into 

area of the scanner glass (see 

es the toolbar (see page 24).

ides the status bar (see page 27).

es the info bar (see page 26).

view image so you can create a 
 scan (see page 64).
HA tour of the scanning 

software
Book Contents Index
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Copy Ctrl+C Does a final scan of the selection area and copie
another program (see page 108).

Select All Ctrl+A Draws a selection area that includes the entire 
page 61).

Clear Selection Esc Removes the selection area (page 60).

E d i t

Toolbar When checked, shows the toolbar. When not checked, hid
Status Bar When checked, shows the status bar. When not checked, h
Info Bar When checked, shows the info bar. When not checked, hid
Undo Zoom When viewing a zoomed image, displays the existing pre

different selection area without performing a new Preview

V i e w



+$%&

2 P PrecisionScan Pro User’s Guide 21

see page 74).

that can be resized in another 

palette (see page 69).

b Palette output type palette plus 
71).

ntains pixel colors present in the 

m color in the scanned image (see 

atted, editable ASCII text (see 

 RTF, HTML, or PDF format (see 
HA tour of the scanning 

software
Book Contents Index
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True Color Scans the selection in 24-bit color (see page 73).

Grayscale Scans the selection in 8-bit grayscale (see page 74).
Black & White

Bitmap (raster) Scans the selection as a black and white raster image (

Scalable (vector) Scans the selection as a black and white vector image 
program without losing image quality (see page 74).

256 Color

Web Palette Scans the selection using colors from a standard Web 
System Palette Scans the selection using colors from the 256 Color We

more shades of gray and the 16 VGA colors (see page
Optimized Palette Scans the selection using colors from a palette that co

original (see page 70).
Spot Color Finds large areas of similar color and makes it a unifor

page 71).
Text Scans a text selection and changes the text into unform

page 98).
Text & Image Scans the selection and saves the text and graphics in

page 101).

O u t p u t  T y p e
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hich sets the resolution for the final 

 sets the amount of sharpening for 

ontains fields for setting the width 
g the width and height of the image 
 dropped (see pages 34 and 65).

l, which sets highlights, shadows, 
ibution, pixel color, and pixel output 

hich sets color balance (hue) and 
).

ol, which sets the threshold and the 
 Bitmap (raster) output type (see 

erses the black and white areas in a 

ansparency Adapter instead of the 

ns tool, to their optimal (default) 

tools are active for all output types.
HA tour of the scanning 

software
Book Contents Index
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Output Resolution When checked, shows the Output Resolution tool, w
scan of the selection (see pages 31 and 90).

Sharpen Level When checked, shows the Sharpen Level tool, which
the image (see pages 33 and 75).

Dimensions When checked, shows the Dimensions tool, which c
and height of the selection area, scaling, and settin
that will be saved, printed, copied, or dragged and

Exposure Adjustment When checked, shows the Exposure Adjustment too
and midtones in the image, and displays pixel distr
levels (see pages 36 and 77).

Color Adjustment When checked, shows the Color Adjustment tool, w
color saturation in the image (see pages 37 and 87

B & W Threshold When checked, shows the Black & White Threshold to
color channel for an image set to the Black & White

pages 38, 92, and 94).
Invert When checked, inverts the image (for example, rev

black-and-white image) (see page 39). 
Use Transparency 
Adapter

When checked, scans the image from the Active Tr
scanner bed (see page 40).

Reset Controls Resets the controls in all tools, except the Dimensio

values.

Not all 

T I P

T o o l s
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 Contents, Index, and Find.

lp (see page 41).

nter  for getting Help by clicking 
 item (see page 41).

anning with HP PrecisionScan Pro 

 scanned images with HP 

eb pages with HP PrecisionScan Pro 

cisionScan Pro CD-ROM that 
of the scanning software (see 

onScan Pro User’s Guide in Acrobat 

atic Document Feeder Guide in 

 software version number.

ader was automatically installed 
allation.
HA tour of the scanning 

software
Book Contents Index
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➮

Contents and Index Displays the Help dialog box for
HP PrecisionScan Pro Help F1 Displays HP PrecisionScan Pro He

What’s This Help Shift+F1 Displays the What’s This Help poi
on a tool, field, button, or menu

HP ScanJet Coach for 
General Scanning...

Ctrl+W Explains the general steps to sc
(see page 42).

HP ScanJet Coach for 
E-mailing Images...

Explains the steps for e-mailing
PrecisionScan Pro (see page 42).

HP ScanJet Coach for 
Creating Web Pages...

Explains the steps for creating w
(see page 42).

Show Me Displays movies from the HP Pre

demonstrate the main features 
page 42).

User’s Guide Displays the HP ScanJet Precisi
Reader (see page 43).

ADF Guide Displays the HP ScanJet Autom
Acrobat Reader (see page 43).

About HP PrecisionScan Pro Displays the HP PrecisionScan Pro

Acrobat Re
during inst

T I P

H e l p
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review image (see page 57).

a (see page 63).

).

109).

see page 108).

 white image (see page 39).

ions tool to their optimal (default) 

(see page 42).

ing Help by clicking on a tool, field, 
HA tour of the scanning 

software
Book Contents Index
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➮

Toolbar

Frequently used commands appear as buttons in the 
toolbar.

Preview Scans the entire scanner glass and displays the p

Zoom Scans and enlarges the view of the selection are

Undo Zoom Displays the existing preview image (see page 64

Save As Scans and saves the selection to a file (see page

Scan To Scans to a selected application (see page 105).

Copy Scans and copies the selection to the Clipboard (

Invert Reverses the black and white areas in a black and

Reset Controls Resets the controls in all tools except the Dimens

values.
Print Scans and prints the selection (see page 104).

HP ScanJet Coach Displays an interactive introduction to scanning 

Help Topics
Displays the What’s This Help pointer  for gett
button, or menu item.

T o o l b a r  B u t t o n s
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eview area

eview area determines how big the 

ing software window when you want 
agnification of the view of a zoomed 

 image after a Zoom scan
HA tour of the scanning 

software
Book Contents Index
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Preview area

The preview area in the scanning software window 
displays the:
■ preview image of the entire scanner glass, or
■ zoomed image of the selection area

When you Preview scan, the entire scanner glass area 
displays in the scanning software window.

Enlarging the pr

The size of the pr
image displays. 

Enlarge the scann
to increase the m
image. 

Preview
area

A selection area in Preview scan

Selection
area

Zoomed
selection

area

Enlarged
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 window info bar

➎

HA tour of the scanning 

software
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Info bar

The info bar displays the following information:
➊ the width of the output image
➋ the height of the output image
➌ scale of the output image
➍ the Output Type currently selected
➎ the Help button for HP PrecisionScan Pro

➊ ➋ ➍

Scanning software

➌
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➋

 window status bar
HA tour of the scanning 

software
Book Contents Index
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➮

Status bar

The status bar displays the following information:
➊ a message about the action you can take when the 

pointer is over some part of the scanning software 
window or a tool

➋ the number of KB (kilobytes), MB (megabytes), 
GB (gigabytes), or TB (terabytes) in the image 
displayed in the selection area (Image Size)
-or-
a progress bar for showing when the scanner is 
scanning or the scanning software is processing a 
command

The Image Size shown in the status bar is the 
number of KB, MB, GB, or TB in the image 
displayed in the selection area. 
This size is only an estimate of the actual size of 
the saved file. The file size depends on the format 
used to save the file (see page 109) and may be 
larger or smaller than the Image Size value shown.

T I P

➊

Scanning software
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 in the preview area.
m’s open document.
on area to the Windows desktop or 

he selection area to resize the width 

r bottom of the selection area to 

of the selection area to resize both 
ea.

ragged to accepts this kind of drop.

o does not accept this kind of drop.
HA tour of the scanning 

software
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Context-sensitive pointers
The shape of the pointer indicates the type of activity 
you can perform in the scanning software.

Selection area pointers

New selection area Draw a new selection area.

Move selection area ■ Move the selection area to a new location
■ Drag the selection area to another progra
■ When Ctrl key is pressed, drag the selecti

to a folder in the Windows Explorer.
Resize selection area 
horizontally

Drag the mouse from a handle on a side of t
of the selection area.

Resize selection area 
vertically

Drag the mouse from a handle on the top o
resize the height of the selection area.

Resize selection area 
diagonally

Drag the mouse from a handle on a corner 
the height and the width of the selection ar

Drop allowed The program or folder the image has been d

Drop not allowed The program the image has been dragged t
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ease or decrease a number.

mage to see the area’s pixel value in 
istogram in the Exposure Adjustment 

mage to see the area’s pixel value in 
togram in the Exposure Adjustment 

r pop-up Help on that item.
HA tour of the scanning 

software
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➮

➮

Ready pointer

Ready for activity ■ Click a menu item to select a command.
■ Click a list button to select a choice.
■ Click a button to turn it on or off, or to incr

Typing pointer

Data entry accepted Click, then type a value.

Pixel value pointers

White eyedropper Position this pointer over a light area of the i
the RGB meter and in the pixel distribution h
tool. Click to set the Highlights value.

Black eyedropper Position this pointer over a dark area of the i
the RGB meter and the pixel distribution his
tool. Click to set the Shadows value.

What’s This Help pointer

What’s This Help Click on a tool, field, button, or menu item fo
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docked to the scanning software 

n tool
ol

ools are docked when you close the 
e, they will be docked the next time 
ning software.

mewhere in the margin of a dockable 
e tool to the toolbar.

l

mewhere in the margin of the docked 

e tools anywhere on the Windows 

 pointer over the tool’s title bar.
g the tool to a new location.
HA tour of the scanning 
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➮

➮

Image adjustment tools
Eight tools can be used to make adjustments to the 
image in the selection area:
■ Output Resolution tool (see page 31)
■ Sharpen Level tool (see page 33)
■ Dimensions tool (see page 34)
■ Exposure Adjustment tool (see page 36)
■ Color Adjustment tool (see page 37)
■ Black & White Threshold tool (see page 38)
■ Invert tool (see page 39)
■ Use Transparency Adapter tool (see page 40)

Each tool has controls you can set for applying to a 
final scan. Five of the tools have reset buttons for 
applying optimal values to their controls.

Displaying a tool
■ From the Tools menu, select the name of the tool you 

want to display. A checkmark displays next to the 
choice in the Tools menu and the tool appears except 
for Invert and Use Transparency Adapter.

Closing a tool
■ Click the Close button  in the tool’s title bar, or

from the Tools menu, select the name of the tool you 
want to hide. The checkmark disappears and the tool 
closes. The tool’s values are still applied to the 
image.

Docking a tool

Two tools can be 
window:
■ Output Resolutio

■ Sharpen Level to

If either of these t
scanning softwar
you start the scan

To dock a tool

■ Double-click so
tool, or drag th

To undock a too

■ Double-click so
tool.

You can place th
desktop.
1 Position the 
2 Click and dra

T I P
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tion

 an output type from the Output Type 
ng software automatically applies the 
solution to the image. You may 
matic setting by selecting a different 
t box in the Output Resolution tool or 
e between 12 and 999,999 in the field 
lution tool.

played on a monitor

 the resolution setting if the image 
 a monitor, such as in email or on a 

mmonly-used resolution settings 
solution tool’s list box in the 
f the HP PrecisionScan Pro 
og box (see page 52).
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➮

➮

Output Resolution tool
The Output Resolution tool lets you determine the 
amount of data for the final scan of an image of a 
picture. See Set output resolution on page 90 for more 
about when to use the Output Resolution tool. 

After you have drawn a selection area, use this tool to:
➊ change the resolution setting, if 

necessary
➋ reset the resolution setting to 

the optimal value for the current 
output type

AutoResolution

When you choose an Output Type, the scanning 
software automatically applies the optimal output 
resolution to the selection area. For example, output 
resolution is automatically set to 200 when the True 

Color output type is selected, and set to 300 for the 
Black & White Bitmap (raster) output type.

To re-apply AutoResolution, click  in the Output 

Resolution tool.

Custom resolu

When you choose
menu, the scanni
optimal output re
override the auto
value from the lis
by typing any valu
of the Output Reso

Images to be dis

Always use 75 as
will be viewed on
Web page.

➊ ➋

You can add co
to the Output Re

Resolution tab o
Preferences dial

T I P
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ange the resolution setting for the 
cture, you will not see the image 
 preview area.
any value between 12 and 999,999 
Resolution tool.
 the resolution setting in the 
tion tool and then change the 
ou can apply AutoResolution for 

ut type by clicking .
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➮

➮

Images to be printed

The resolution setting for printing images varies, 
depending on the output type applied to the image and 
the maximum resolution capability of the printer (see 
page 90).

To print images of photographs with the True Color, 256 

Color, or Grayscale output types, set the value in the 
Output Resolution tool according to the following table.

To print images of drawings with the 256 Color or Black 

& White Bitmap (raster) output types, set the value in the 
Output Resolution tool equal to the resolution of the 
printer.

300 dpi 
printer

600 dpi 
printer

1200 dpi 
printer

Resolution tool 
setting

100 200 300

You can change the resolution settings available in 
the Resolution tool’s list box 
(see page 52).

T I P

■ When you ch
image of a pi
change in the

■ You can type 
in the Output 

■ If you change
Output Resolu
output type, y

the new outp
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t a new sharpen level in the 
ol, the result of the new sharpen 
n in the preview area.

rayscale output type

n level Extreme sharpen level
HA tour of the scanning 
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➮

➮

Sharpen Level tool
The Sharpen Level tool lets you enhance details in the 
image of a picture for the final scan. See Sharpen on 
page 75 for more about how to use the Sharpen Level 

tool.

When you choose an Output Type for the image of a 
picture, the scanning software automatically applies 
the optimal sharpen level. 

After you have drawn a selection area, use this tool to:
➊ select a sharpen level from 

the list box, if necessary
➋ reset the sharpen level 

setting to the optimal value 
for the current output type

The choices in the Sharpen Level 
list box are listed in order from 
the least amount of sharpening to the most amount of 
sharpening:
■ None
■ Low
■ Medium
■ High
■ Extreme

➊ ➋

After you selec
Sharpen Level to
level can be see

T I P
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 tool, you can:
ons of the selection area
 the selection area and the output 

 to a percentage of the size of the 

imensions of the image for the final 

50% Scaled image
HA tour of the scanning 
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➮

➮

Dimensions tool
The Dimensions tool lets you change the size of the 
scanned image of a picture so that the image will be 
the size you want it when you use the image in another 
program or print it. For example, you can save a small 
scanned image from a larger original picture.

In the Dimensions

■ set the dimensi
■ set the units for

dimensions
■ scale the image

original
■ set the output d

scan

Original picture

Scale
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 dimensions on page 65 for more 
 the Dimensions tool.

➎

➍

HA tour of the scanning 
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➮

➮

After you have drawn a selection area, use the 
Dimensions tool to:

See Set the output

about how to use

➊ adjust the dimensions of the selection area
➋ set values for the width and height of the image to 

be included in the final scan
➌ select the units you want to work with
➍ enlarge or reduce output dimensions of the image 

for the final scan proportionally by scaling to a 
percentage of the original’s size

➎ lock the output dimensions so you can change the 
dimensions of the selection area without changing 
the output dimensions

➊

➋

➌

To preserve image quality when you use it in 
another program:
■ measure the dimensions of the area in which 

you will place the image, then
■ use the Dimensions tool in HP PrecisionScan Pro to 

scale or resize the image to fit that area.

T I P
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ge exposure settings in the 
tment tool, the results of the 
e seen in the preview area.

➑

➏
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➮

➮

Exposure Adjustment tool
The Exposure Adjustment tool lets you make fine 
adjustments to highlights, shadows, and midtones, or 
set the output level of black and white pixels in a color 
or grayscale image of a picture. See Adjust exposure on 
page 77 for more about how to use the Exposure 

Adjustment tool.

After you chan
Exposure Adjus

changes can b

T I P

After you have drawn a selection area, use this tool 
to:
➊ adjust highlights in the image
➋ adjust shadows in the image
➌ adjust midtones in the image
➍ adjust output level of white pixels
➎ adjust output level of black pixels
➏ view black pixels that will be clipped in the final 

scan
➐ view white pixels that will be clipped in the final 

scan
➑ view RGB values and pixel distribution for any 

light or dark area of the image
➒ reset all the exposure controls to the values 

determined by the scanning software

➊
➋

➌

➍
➎

➒
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awn a selection area, use this tool to:
 by dragging the indicator circle in 

l with the mouse
 by clicking a color’s triangle on the 

move the indicator circle
ation between 0 and 150; the higher 
value, the brighter the colors
 by typing X and Y values for the 

 controls to the values determined by 
oftware

e settings in the Color Adjustment 

 of the new settings can be seen in 
a.
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➮

➮

Color Adjustment tool
The Color Adjustment tool lets you change the hue and 
make colors brighter in a color image. 

See Adjust color on page 87 for more about how to use 
the Color Adjustment tool.

After you have dr
➊ change the hue

the Color Whee

➋ change the hue
Color Wheel to 

➌ set color satur
the saturation 

➍ change the hue
Color Wheel.

➎ reset the color
the scanning s

➊

➌

➎

➋
➍

After you chang
tool, the results
the preview are

T I P
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e settings in the Black & White 

he results of the new settings can 
review area.

 Bitmap (raster) output type
HA tour of the scanning 
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➮

➮

Black & White Threshold tool
The Black & White Threshold tool lets you change the 
dividing point for black and white pixels in an image 
that uses the Black & White Bitmap (raster) output type. 
All pixels below the threshold will be output as black 
and all pixels above the threshold will be output as 
white. 

After you have drawn a selection area, use this tool to:
➊ view the distribution of black and white pixels in the 

selection area
➋ set the black and white threshold (see page 92)
➌ set the color channel
➍ set the black and white threshold to the value 

determined by the scanning software

➋

➍➊

➌

After you chang
Threshold tool, t
be seen in the p

T I P

Black & White

Default
threshold
setting

Low
threshold
setting
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 Bitmap (raster) output type
HA tour of the scanning 
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➮

➮

Invert tool
The Invert tool converts the white areas of an 
image to black and the black areas to white. For color 
images, the complementary color is scanned. 

You can invert an image if you save to a raster output 
types, such as TIFF, GIF, or JPEG. Scans saved as B&W 
Vector, Text and Text with Images can not be inverted. 
In general, Invert is useful for drawings and spot color 
images.

When you turn on the Invert option, the inverted 
image is displayed in the preview area.

T I P

Black & White

Normal

Inverted
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➮

➮

Use Transparency Adapter Tool
The Use Transparency Adapter tool lets you scan from 
the connected Active Transparency Adapter (XPA), 
instead of scanning from the scanner bed.

When Use Transparency Adapter is checked in the Tools 
menu, the XPA icon appears in the status bar.

This menu item is available only if the Transparency 
Adapter is connected. See Active Transparency Adapter 
on page 115 for more details.

If the menu item is “dimmed,” shut down HP 
PrecisionScan Pro, connect the Active 
Transparency Adapter to the back of the scanner, 
and re-start HP PrecisionScan Pro.

N O T E
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his Help for a tool

itle bar of a tool to change the pointer 

 a tool.
escription appears. 

an Pro Help

can Pro Help to learn about using the 
e and the scanner.

m the Desktop

 the Windows Start button.
menu, choose Programs, then choose 
ware:HP Online Help:HP ScanJet Help.

Scan Pro Help window appears.

m the scanning software window

ing software Help menu, select 
Pro Help or Contents and Index, or

info bar.

Scan Pro Help window appears.
HA tour of the scanning 
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➮

➮

Online Help

Quick Help in the scanning software window

A short description, or ToolTip, displays when you 
move the pointer over of each part of the scanning 
software window or a tool, and a longer description 
displays in the status bar.

What’s This Help in the scanning software 
window

Use What’s This Help to learn about any object in the 
scanning software window.

To use What’s This Help for the scanning software 
window

1 Click  in the toolbar, or the  in the title bar of a 

tool, to change the pointer to .

2 Click an item in the scanning software window or in a 
tool. 

A popup Help description appears. 

You can also press Shift+F1 to display the What’s This 
pointer for the scanning software window.

To use What’s T

1 Click  in the t
to .

2 Click an item in
A popup Help d

HP PrecisionSc

Use HP PrecisionS

scanning softwar

To start Help fro

1 Select ,
2 From the Start 

HP ScanJet Soft

The HP Precision

To start Help fro

■ From the scann
HP PrecisionScan

click  in the 

The HP Precision
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 basic scanning concepts can be 
e HP PrecisionScan Pro CD. 
ecisionScan Pro CD into the CD-ROM 

puter speakers.

from the Desktop

 the Windows Start button.
menu, choose Programs, then choose 
ware:HP Online Help:Show Me Videos.

from the Help menu

ing software.
enu, choose Show Me.

from online Help

 active at the top of a Help 

 

HA tour of the scanning 
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➮

➮

HP ScanJet Coach

Use the HP ScanJet Coach to learn the steps for 
scanning. Coaches are available for General Scanning,
E-mailing Images and Creating Web Pages.

To start the HP ScanJet Coach from the Desktop

1 Select , the Windows Start button.
2 From the Start menu, choose Programs, then choose 

HP ScanJet Software:HP Online Help:HP ScanJet Coach.

The HP PrecisionScan Pro Help window appears.

The HP ScanJet Coach appears.

To start a HP ScanJet Coach from the scanning 
software

■ Click  in the scanning software toolbar, or from 
the scanning software Help menu, select HP ScanJet 
Coach for General Scanning, HP ScanJet Coach for 
E-Mailing Images, or HP ScanJet Coach for Creating Web 
Pages.

The HP ScanJet Coach appears.

Videos

Several videos of
accessed from th
1 Insert the HP Pr

drive.
2 Turn on the com

To start a video 

1 Select ,
2 From the Start 

HP ScanJet Soft

To start a video 

1 Start the scann
2 From the Help m

To start a video 

When you see 
topic,
■ Click .
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➮

➮

Online manuals

In addition to this HP PrecisionScan Pro User’s Guide 
online manual, you can view the HP ScanJet Automatic 
Document Feeder Guide in Adobe Acrobat Reader, which 
describes how to use the HP ScanJet Automatic 
Document Feeder.

To view an online manual from the Desktop

1 Select , the Windows Start button.
2 From the Start menu, choose Programs, then choose 

HP PrecisionScan Pro:HP Online Help and the manual.

Adobe Acrobat Reader starts and displays the online 
manual.

To view an online manual from the scanning 
software

■ From the scanning software Help menu, select the 
manual.

Adobe Acrobat Reader starts and displays the online 
manual.
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Save Settings dialog box
Output Settings tab
HA tour of the scanning 

software
Book Contents Index

➮

➮

Save and re-use adjustment settings
You can save the settings you have made to an image 
and apply those settings to a another scan during the 
current scanning session or after restarting 
HP PrecisionScan Pro. When you save a set of settings, 
you give the set of settings a name. 

When you want to use those settings for a different 
image, load the settings using the same name 
(page 46). 

The settings saved are:
■ Output Type

■ Dimensions tool values (output size and output scale)
■ Output Resolution tool value
■ Sharpen Level tool value
■ Exposure Adjustment tool values
■ Color Adjustment tool values
■ Black & White Threshold tool value
■ Invert

■ Use Transparency Adapter

■ the selection area, if one existed
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 settings

menu, select Save Settings...

gs dialog box appears (see page 44).
ings listed in the Output Settings and 
gs tabs.
re acceptable for saving, click in the 
 Save Settings dialog box, then type a 
ttings.

ings dialog box closes.
et of settings is saved for future use 
.

HA tour of the scanning 
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➮

➮

Saving a set of

1 From the Scan 

The Save Settin

2 Review the sett
the Tools Settin

3 If the settings a
text field of the
name for the se

4 Click Save.
• The Save Sett

• The named s
(see page 46)

Save Settings dialog box
Tools Settings tab
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menu, select Load Settings...

gs dialog box appears.
x, select the name of the set of 
nt to load.
ings listed in the Output Settings and 
gs tabs.
re acceptable for loading, click Load.
ings dialog box closes.
re applied to the image.

of settings

menu, select Save Settings...

gs dialog box appears.
x, select the name of the set of 
nt to delete.

 dialog box appears.

gs is deleted from the list of saved 
HA tour of the scanning 

software
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➮

➮

Loading a set of settings

Any set of scanning settings you have saved with the 
Save Settings dialog box can be applied to the image 
currently displayed in the preview area. 

1 From the Scan 

The Load Settin

2 From the list bo
settings you wa

3 Review the sett
the Tools Settin

4 If the settings a
• The Load Sett

• The settings a

Deleting a set 

1 From the Scan 

The Save Settin

2 From the list bo
settings you wa

3 Click Delete.

The Delete setting

4 Click Yes. 

The set of settin
settings.

Load Settings dialog box
Output Settings tab

The settings name is selected
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PrecisionScan Pro Preferences 

enu, select Preferences...

Scan Pro Preferences dialog box 

➌ ➍ ➎
HA tour of the scanning 
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➮

➮

Set preferences
Preferences for the scanner and the scanning software 
can be set in the HP PrecisionScan Pro Preferences dialog 
box.

The HP PrecisionScan Pro Preferences dialog box has 
several tabs. These tabs are:
➊ Scanner (see page 48)
➋ Selection Area (see page 50)
➌ Resolution (see page 52)
➍ Controls (see page 53)
➎ Text (see page 54)

Opening the HP
dialog box
■ From the Scan m

The HP Precision

appears.

To activate a checkbox choice in the 
HP PrecisionScan Pro Preferences dialog box: 

■ Click the checkbox to place a checkmark in it .
To activate an option button choice in the 
HP PrecisionScan Pro Preferences dialog box: 

■ Click the option button to place a dot in it .

✔

●

T I P
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 choices in this tab are turned on
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➮

➮

Scanner tab

The Scanner tab of the HP PrecisionScan Pro Preferences 
dialog box has checkboxes for enabling:

➊ a Preview scan when the scanner’s Scan button 
 is pushed (page 49)

➋best quality scaling (page 49)
➌best quality sharpening (page 49)
➍maximum pixel depth (page 49)

To change settings:

1 Select the checkboxes you want to turn on or off.
2 Click Apply.
3 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

➊

➋
➌
➍

All the checkbox
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 Depth

ox is checked, the largest pixel bit 
o the scan to produce the highest 

ox is not checked, scanning is faster 
pes because there is less image data 

 

n HP PrecisionScan Pro is installed, 
es are checked in the Scanner tab of 

Scan Pro Preferences dialog box.
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➮

➮

Preview scan when scanner button is pushed

When this checkbox is checked, each time you push the 
Scan button on the scanner the scanner 
automatically performs a Preview scan. This means you 
can start a Preview scan with the Scan button.

When this checkbox is not checked, pushing the Scan 
button on the scanner does not start a Preview 
scan. You will need to start a Preview scan by: 
■ clicking  in the toolbar

-or-
choosing Preview from the Scan menu

Best Quality Scaling

When this checkbox is checked, the highest quality 
scaling is applied to the final scan.

When this checkbox is not checked, scanning is faster 
because normal quality scaling is applied to the final 
scan.

Best Quality Sharpening

When this checkbox is checked, the highest quality of 
sharpening is applied to the final scan.

When this checkbox is not checked, scanning is faster 
because normal quality sharpening is applied to the 
final scan.

Maximum Pixel

When this checkb
depth is applied t
quality image.

When this checkb
for most output ty
being processed.

By default, whe
all the checkbox
the HP Precision

T I P
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en HP PrecisionScan Pro is installed, 
xes are checked in the Selection Area 
recisionScan Pro Preferences dialog 
HA tour of the scanning 
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➮

➮

Selection Area tab

The Selection Area tab of the HP PrecisionScan Pro 
Preferences dialog box has checkboxes for controlling 
whether the scanning software should automatically:

➊ create a selection area when the mouse is clicked 
(page 51)

➋determine the best Output Type for the selection area 
(page 51)

➌determine the optimal exposure level for the 
selection area (page 51)

➍determine the optimal color balance and saturation 
for the selection area (page 51)

To change settings:

1 Select the checkboxes you want to turn on or off.
2 Click Apply.
3 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

➊
➋
➌
➍

By default, wh
all the checkbo
tab of the HP P

box.

T I P
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ox is not checked, the scanning 
t change the current output type when 
rea is created. You will need to 
e appropriate output type from the 
 when you create a new selection 

djust exposure after selection

ox is checked, each time you create a 
a by clicking (see page 59), the 
e automatically changes the controls 
justment tool to the optimal values.

ox is not checked, the scanning 
t automatically reset the controls the 
nt tool when you create a new 

djust color after selection

ox is checked, each time you create a 
a by clicking (see page 59), the 
e automatically changes the controls 
ment tool to the optimal values.

ox is not checked, the scanning 
t automatically reset the controls in 
ent tool when you create a new 
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➮

➮

Automatically create selection area after a mouse 
click

When this checkbox is checked, the scanning software 
automatically creates a selection area when you click 
over a part of the image while the pointer looks like 
this: .

When this checkbox is not checked:
■ the scanning software does not automatically create 

a selection area when you click over a part of the 
image

■ you will need to draw the selection area (see page 60)

Automatically set the output type after selection

When this checkbox is checked, the scanning software 
automatically changes the output type for a new 
selection area created by clicking (see page 59). The 
scanning software determines which output type to 
apply based on the contents of the selection area:
■ True Color is applied when the selection area contains 

enough color
■ Grayscale is applied when the selection area contains 

mostly grayscale information
■ Black and White Bitmap (raster) is applied if the 

selection area contains mostly black and white 
information

■ Spot Color is applied when the selection area contains 
large areas of similar color.

When this checkb
software does no
a new selection a
manually select th
Output Type menu
area.

Automatically a

When this checkb
new selection are
scanning softwar
in the Exposure Ad

When this checkb
software does no
Exposure Adjustme

selection area.

Automatically a

When this checkb
new selection are
scanning softwar
in the Color Adjust

When this checkb
software does no
the Color Adjustm

selection area.
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lution default:

n List, select the resolution you want 

b, or click OK to close the 
n Pro Preferences dialog box.

➍
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➮

➮

Resolution tab

To add a resolution default:

1 Click Add. 
2 In the Default Resolution dialog box, type a number 

between 12 and 999,999.
3 Click OK.
4 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

To delete a reso

1 In the Resolutio

to delete.
2 Click Delete.
3 Click another ta

HP PrecisionSca

The Resolution tab of the HP PrecisionScan Pro 
Preferences dialog box controls the resolution values 
contained in the Output Resolution tool’s list box. It has:
➊ a list of the resolution values currently available in 

the Output Resolution tool’s list box
➋ an Add button for adding a resolution to the Output 

Resolution tool’s list box
➌ a Delete button for deleting a resolution from the 

Output Resolution tool’s list box
➍ the two resolutions that always remain in the Output 

Resolution tool’s list box

➊

➌

➋
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 sets the amount of tonal resolution 
e for correction in the Exposure 

lack & White Threshold tools. Using a 
bits for the control range results in 
 compensation for exposure or 
ion.
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➮

➮

Controls tab

The Controls tab of the HP PrecisionScan Pro Preferences 
dialog box has option buttons for selecting which 
control range readout to use for scanning.

The control range
per color availabl
Adjustment and B
larger number of 
greater control of
threshold correct

➊ 8-bit readout (0-255) — sets the scanner to use 8 bits 
of tonal resolution per color

➋ 10-bit readout (0-1023) — sets the scanner to use 10 
bits of tonal resolution per color

➌ 12-bit readout (0-4095) — sets the scanner to use 12 
bits of tonal resolution per color

To change settings:

1 Click the option button to select it.
2 Click Apply.
3 Click another tab, or click OK to close the 

HP PrecisionScan Pro Preferences dialog box.

➊
➋
➌
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➮
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Text tab

The Text tab of the HP PrecisionScan Pro Preferences 
dialog box allows you to select one of the following for 
the RTF output:
■ Framed text: Puts the text from the page in frames 

and attempts to recreate the page formatting as 
closely as possible to the original.

■ Flowed text: Eliminates the columns on the page and 
inserts any images in the text as closely as possible 
to where they were in the original.
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58 Create a sele

63 Zoom scan

64 Return to the
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e with a 
ut type:
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d white 
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➮

➮

Basic steps for scanning pictures

Quick scan

1 Preview scan (page 57).
2 Create a selection area of the part of the image you 

want in the final scan (page 58).
3 Scan to a destination, save, copy, drag-and-drop, or 

print (see Chapter 6 Saving scanned images page 102).

Optional adjustments

(See Chapter 4 Adjusting images of pictures page 72.)
■ Zoom scan to see the image at closer range (page 63).
■ Set the output dimensions if you want to save the 

image as a different size (page 65).
■ Choose an Output Type if you need to save the image 

with different colors. For example, you could save a 
color image as a grayscale or a 256 color image 
(page 69).

To adjust an imag
True Color or a 256

output type:
■ Sharpen (page
■ Adjust exposur
■ Adjust color (pa

To adjust an imag
Grayscale output t
■ Sharpen (page
■ Adjust exposur

To adjust an imag
Black & White outp
■ Sharpen (page
■ Adjust black an

threshold (page
channel (page 9

Be sure to keep the original in the same place on 
the scanner glass until the final scan of the image is 
completed.

T I P
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 displayed in the preview area
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➮

➮

Preview scan
A Preview scan displays a low-resolution image of 
everything on the scanner glass so you can create a 
selection area to work with (see page 58). A final scan 
will be performed when the image is saved, copied, 
printed, or dragged to another program.

Using the Scan button to Preview scan

If the ScanJet Button Manager is set to communicate 
with HP PrecisionScan Pro:
■ Push the Scan button  on the scanner once.

The scanner performs a Preview scan and the 
preview image appears in the preview area.

For information on configuring the HP ScanJet Button 

Manager, see page 12.

Using the scanning software to Preview scan

You can Preview scan from the scanning software:
■ Click , the Preview button in the toolbar, or
■ from the Scan menu, select Preview, or
■ press Ctrl+R.

The scanner performs a Preview scan and the 
preview image appears in the preview area.

A Preview scan

Preview
area
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➮

➮

Create a selection area 
You must create a selection area to indicate the part of 
the image you want to save to a file, copy, print, drag-
and-drop, or send to a destination. 

The area you select will be enclosed by a selection 
border, which you can resize later (see page 62).

There are several ways to create a selection area:
■ click (see page 59)
■ draw (see page 60)
■ select everything on the scanner glass (see page 61)

The selection area determines the part of the image 
that is included in the final scan when you save, 
copy, print, or drag-and-drop.

If no selection area exists: 
■ you cannot perform drag-and-drop
■ the entire area of the scanner glass will be 

included when you save, copy, or print

T I P
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ction border around the picture 
HScanning pictures Book Contents Index

➮

➮

Clicking to create a selection area

1 Position the  pointer near the upper-left corner of 
the area you want to work with.

2 Click.

A rectangular selection area is created and the parts 
of the preview image outside the selection area are 
faded to indicate they will not be included in the final 
scan.

To enable clicking to create a selection area enable 
the Selection Area preference option Automatically 
create selection area after a mouse click (see 
page 51).

T I P

A sele

Selection
area
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selection area

e selection area so you can create a 

enu, select Clear Selection, or

der surrounds the selection area.
ar on the corners and in the middle 
f the selection border.

side the selection border remains 

tside the selection border appears 
HScanning pictures Book Contents Index

➮

➮

Drawing to create a selection area

1 Position the  pointer over one corner of the area 
you want to select.

2 Press the mouse button and drag the pointer 
diagonally to create a selection border.

3 Release the mouse button.

Removing the 

You can delete th
different one.
■ From the Edit m
■ press Esc.

Selection
area

Handles

Selection border

■ A dashed bor
■ Handles appe

of each side o
■ The image in

vivid.
■ The image ou

faded.

T I P
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ction border around the entire 
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➮

➮

Selecting the entire preview area

After a Preview scan, use the Select All command to 
create a selection area containing the entire preview 
area.
■ From the Edit menu, select Select All

– or –
press Ctrl+A.

A selection border is drawn around the entire 
preview area.

Selecting the entire zoomed area

After a Zoom scan, use the Select All command to create 
a selection area containing the entire zoomed area.
■ From the Edit menu, select Select All

– or –
press Ctrl+A.

A selection border is drawn around the entire 
zoomed area.

A sele

Preview
area
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ions tool

ields in the Selection Area Dimensions 
sions tool to define the exact size of 
. (See page 34 for more about the 

menu, select Dimensions.

 tool appears.
tton in the Units field and select the 
 to work with.
 of the selection area, type the width 

dth field of the Selection Area 

.
e aspect ratio for the selection area 

tion Area Dimensions area height value 
 the new width value), press Enter, 

sting Selection Area Dimensions area 
ick in any other field of the Dimensions 
HScanning pictures Book Contents Index

➮

➮

Moving the selection area

You can move the selection area to a different location 
in the preview area.
1 Position the pointer inside the selection area.

The pointer changes to .
2 Drag the selection area to its new location.

Adjusting the size of selection area

You can change the size of the selection area two ways:
■ click and drag one of the handles on the selection 

border (see the picture on page 60)
■ set dimensions for the selection area in the 

Dimensions tool

Use the handles on the border

1 Position the pointer over the handle on the corner or 
side of the selection border you need to adjust.

The pointer changes to a bidirectional arrow (see 
page 28).

2 Click on the handle and drag the side of the border to 
a new location.

3 Release the mouse button.

Use the Dimens

You can use the f
area of the Dimen

the selection area
Dimensions tool.)
1 From the Tools 

The Dimensions

2 Click the list bu
units you want

3 To set the width
value in the Wi

Dimensions area
4 To keep the sam

(keep the Selec

proportional to

-or-

to leave the exi
height value, cl
tool.
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selection
HScanning pictures Book Contents Index

➮

➮

Zoom scan
Zoom scan lets you view the selection area at closer 
range. Use the Zoom command to see the image better 
when you adjust it.

Performing a Zoom scan

1 Create a selection area (page 58).
2 To enlarge the view of the selection area:

• Click , the Zoom button in the toolbar

– or –
• from the Scan menu, choose Zoom.

The scanner scans the selection area and the 
selection area fills the preview area.

Zoomed 
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oom)
enu, choose Undo Zoom.

age appears with all settings 

nt area of the preview image.

oom button in the toolbar, 

enu, choose Zoom.

ans the selection area.

 new selection area appears enlarged.

 image

Zoom

Second zoomed image

➌

HScanning pictures Book Contents Index

➮

➮

Return to the preview image (Undo Z
After you have used the Zoom command to enlarge the 
view of the selection area, you can use the Undo Zoom 
command to view the preview image without 
performing another Preview scan. This can be useful 
when you have several pictures on the scanner glass 
and you want to use each one individually.

Using Undo Zoom

Use the Undo Zoom command when you want to create 
a different selection area in the preview image.
1 Click , the Undo Zoom button in the toolbar, 

– or –

from the View m

The preview im
preserved.

2 Select a differe

3 Click , the Z
– or –
from the Scan m

The scanner sc

The view of the

Preview image

Zoom

First zoomed image Preview image Preview

Undo Zoom Click

➊ ➋
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ure for setting output dimensions 
:
ts of measurement you want to work 

on area (page 58) and adjust the size 
 area (page 62).
ut dimensions (page 67).

400% Scaled image
HScanning pictures Book Contents Index

➮

➮

Set the output dimensions
To get the best quality image, determine in advance the 
physical dimensions you want for the image and set 
those dimensions with the Dimensions tool in the 
scanning software. For example, if the original is 
smaller than the size you need the image to be in 
another program, resize it now. Resizing an image in 
the destination program can cause the image to 
become fuzzy or jagged.

The usual proced
follows this order
1 Choose the uni

with (page 66).
2 Create a selecti

of the selection
3 Adjust the outp

Original picture Create a selection
area

Set output
dimensions
by scaling

Print,
save,
copy, or
drag-and-
drop

➊ ➌
Set units

➋

Scale
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on area (page 58).
tton in the Units field of the 
l and select a unit of measurement.

ge units:
dth value in both Width fields 

ight value in both Height fields 

dth value in the info bar changes
ight value in the info bar changes
HScanning pictures Book Contents Index

➮

➮

See page 34 for more about the Dimensions tool.

Setting units

The Units field in the Dimensions tool sets the units of 
measurement for the Width and Height fields in the 
Selection Area Dimensions and the Output Dimensions 
areas. The units available are:
■ inches

■ centimeters

■ points

■ pixels

To set units

1 Create a selecti
2 Click the list bu

Dimensions too

When you chan
■ the output wi

changes
■ the output he

changes
■ the output wi
■ the output he

T I P
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ge the Scale value, you will not see 
ge in the preview area.

when Scale is set to 100%

when Scale is set to 50%
HScanning pictures Book Contents Index

➮

➮

Scaling output as a percentage of the original

The Scale field is useful for setting output dimensions 
when you know approximately how big you want the 
final image to be.

For example, when you want the image to be half the 
size of the original, set the value in the Scale value to 
50%. Or if you want the final image to be twice the size 
of the original, set the Scale value to 200%.
1 Create a selection area (page 58).
2 Click the list button in the Scale field and select a 

percentage

-or-

type a value in the Scale field, then press Enter.

The new output width appears in the Width field in 
the Output Dimensions area and in the info bar. 

The new output height appears in the Height field in 
the Output Dimensions area and in the info bar. 

The new scale percentage appears in the Scale field 
and in the info bar.

The new image size displays in the Image Size box in 
the status bar.

The selection area remains the same.

When you chan
the image chan

T I P

Image output 

Image output 
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 for output dimension

utput dimensions you have defined 
e the size of the selection area without 
ut dimensions.

on area (page 58).
or width and height in the Output 

 of the Dimensions tool.

of the selection area (see page 62).

rea will be resized proportionally.

ensions remain the same.
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➮

➮

Typing values for output width and height

You can type the output dimensions when you know 
exactly how big you want the final image to be.
1 Create a selection area (page 58).
2 Click in the Width field of the Output Dimensions area 

of the Dimensions tool and type the value for the 
width

3 Press Tab or Enter, 

– or –

click in the Height field of the Output Dimensions area 
and type the value for the height, then press Tab or 
Enter.
• The new output width appears in the Width field of 

the Output Dimensions area and in the info bar. 
• The new output height appears in the Height field 

of the Output Dimensions area and in the info bar. 
• The new scale percentage appears in the Scale field 

and in the info bar.
• The new image size displays in the Image Size box 

in the status bar.
• The selection area remains the same.

Locking values

You can lock the o
so you can chang
changing the outp
1 Create a selecti
2 Set the values f

Dimensions area

3 Click .
4 Adjust the size 

The selection a

The output dim
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put type selected by the scanning 
 be the most appropriate for the way 

age. For example, when you want to 
f a color photograph on a black and 
 may want to set the output type to 

s are more suitable for images that 
on a monitor, others are more 
ng.

71 lists results you can get with each 
rious types of originals.
HScanning pictures Book Contents Index

➮

➮

Choose an output type
The output type selected in the Output Type menu 
determines the bit depth and color palette applied to 
the final scan of pictures and drawings, but not for 
images that will be converted to text. The table on 
page 71 lists bit depths and color palettes for each 
output type that is appropriate for images of pictures 
and drawings. 

The scanning software automatically selects an 
appropriate output type based on the contents of the 
selection area. The current output type setting displays 
in the info bar of the scanning software window.

However, the out
software may not
you will use the im
print the image o
white printer, you
Grayscale.
Some output type
will be displayed 
suitable for printi

The table on page
output type for va

True Color 24-bit, millions of colors

Grayscale 8-bit, 256 shades of gray

Black & White
Bitmap (raster), 
Scalable (vector)

1-bit black and white

256 Color
Web Palette
System Palette
Optimized Palette

8-bit, 256 colors

Spot Color 8-bit, 256 colors

O u t p u t  t y p e s  f o r  p i c t u r e s
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 with images that will be used on 
y monitors, do not use the 256 Color 

e output type. 
ized palette is used in an image:
 unique to that image and the 
e colors are applied to the window 
ing the image
r windows that are displayed at the 
ll be corrupted, because those other 
 a standard, system palette
isplaying the image with the 

lette will be temporarily rendered 
lors when focus changes to a 
ow
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➮
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Changing the output type

1 Create a selection area (page 58).
2 From the Output Type menu, choose an output type 

for the image of the picture you scanned.

Make your output type choice based on:
• whether the image will be displayed on a monitor 

or printed in hardcopy
• how many colors you want in the final scan
• file size

After you select an output type from the Output Type 
menu:

• you will see the image change in the preview area
• the new output type displays in the info bar
• the new image size displays in the status bar
• a new sharpening level may appear in the Sharpen 

Level tool
• a new value may appear in the Output Resolution 

tool

For best results
256-color displa
Optimized Palett

When an optim
■ that palette is

unique palett
that is display

■ colors in othe
same time wi
windows use

■ the window d
optimized pa
with fewer co
different wind

T I P
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riginal

lack and white 
hotograph

Black and white 
drawing

ne-color tint image for printing

g on a monitor

 or displaying on a monitor; not 
ram

r resizing in another program

ne-color tint image for displaying on 
 Web page

ne-color tint image for displaying a 
resentation on a monitor

not recommended
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➮
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Suggestions for choosing output type

Type of o

Output Type Color 
photograph

Color 
drawing

B
p

True Color

millions of colors (24-bit color) best color image for printing o

Grayscale

8-bit (256 shades of gray) grayscale image for printing or displayin

Black & White

1-bit black and 
white 
(only black 
and white)

Bitmap (raster) black and white raster image for printing
appropriate for resizing in another prog

Scalable (vector) scalable black and white vector image fo

256 Color 

8-bit color 
(256 shades of 
color)

Web Palette best color for displaying images on 
a Web page

o
a

System Palette best color for displaying wallpaper, 
multiple images, or a presentation 
on a monitor

o
p

Optimized Palette best for selecting the colors closest 
to those in the image

Spot Color not 
recommended

eliminates small 
variations in a 
solid color block
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 for black and white bitmaps

nnel for black and white bitmaps

s

4
➮

➮

Adjusting 
pictures

73 Tools for ma

75 Sharpen

77 Adjust expos

87 Adjust color

90 Set output re

92 Set threshold

94 Set color cha

96 Invert option
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pe affects which image 
u can make

le for making adjustments to an 
 depend on the Output Type you have 

 color output types

e True Color 
put type can 
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Tools for making adjustments
The tools in the scanning software can be used to 
adjust the image of a picture before you save, copy, 
drag-and-drop, or print the image. 

After you have selected an output type (page 69) and 
cropped the image by creating a selection area 
(page 58), the adjustments you can make and the tools 
to use are:

How output ty
adjustments yo

The tools availab
image of a picture
selected.

Adjustments for

An image with th
or a 256 Color out
be adjusted for:
■ sharpening
■ exposure
■ color
■ resolution

Adjustment Tool

■ sharpening Sharpen Level, page 75

■ exposure Exposure Adjustment, page 77

■ color Color Adjustment, page 87

■ resolution Output Resolution, page 90

■ black and white
threshold

Black & White Threshold, page 92

■ invert Invert options page 96, 

To get the best scanned image, use the tools in the 
scanning software to make adjustments instead of 
making adjustments in another program.

T I P
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 Black & White Bitmap (raster) 

e Black & 

er) output 
ted for:

 threshold

 Black & White Scalable (vector) 

e Black & 

ctor) output 
justed with 
HAdjusting images of 

pictures
Book Contents Index
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Adjustments for Grayscale output type

An image with the Grayscale 
output type can be adjusted 
for:
■ sharpening
■ exposure
■ resolution

Adjustments for
output type

An image with th
White Bitmap (rast

type can be adjus
■ sharpening
■ resolution
■ black and white

Adjustments for
output type

An image with th
White Scalable (ve

type cannot be ad
any of the tools.



+$%&

4 P PrecisionScan Pro User’s Guide 75

oftware automatically selects the 
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rue Color output type

n level High sharpen level
HAdjusting images of 

pictures
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➮

➮

Sharpen
The right amount of sharpening enhances detail in the 
scanned image. Too much or too little sharpening can 
accent flaws and emphasize undesirable patterns in 
images of photographs, drawings, or line art.

If the original picture is not sharp, or you want to create 
a special effect, you can increase or decrease 
sharpening with the Sharpen Level tool. The sharpen 
level you select will be applied to the final scan.

See page 33 for more about the Sharpen Level tool.

Grayscale output type

Medium sharpen level Extreme sharpen level

The scanning s
optimal sharpe
to the image.

T I P
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Medium sharpe



+$%&

4 P PrecisionScan Pro User’s Guide 76

efault sharpen level

utoSharpen button in the Sharpen Level 

harpen level determined by the 
ware is applied to the Sharpen Level 

the change to the sharpen level can 
 preview area.

ange the sharpen level for the 
cture, you will see the image 
 preview area.
 the sharpen level in the Sharpen 
 then change the output type, you 

toSharpen
utput type by clicking .
HAdjusting images of 

pictures
Book Contents Index

➮
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Changing the sharpen level

1 From the Tools menu, select Sharpen Level.

The Sharpen Level tool appears (see page 33).
2 Click the list box button, drag to the sharpen level 

you want, then release the mouse button,

– or –

Click in the sharpen level text field and type the first 
letter of a sharpen level.
• The new sharpen level is applied.
• The result of the change to the sharpen level can 

be seen in the preview area.
• The AutoSharpen button in the Sharpen Level tool 

becomes active.

Applying the d

■ Click , the A
tool.
• The optimal s

scanning soft
tool.

• The result of 
be seen in the

Black & White Bitmap (raster) output type

None sharpen level Extreme sharpen level

■ When you ch
image of a pi
change in the

■ If you change
Level tool and
can apply Au
for the new o

T I P
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sure Adjustment tool

menu, select Exposure Adjustment.

justment tool appears. (See page 36.)
owing sections for using the Exposure 

l:
hts on page 78

s on page 79

es (brightness) on page 80

ping of pixels on page 83

put levels on page 85

efault exposure settings
utton in the Exposure Adjustment tool.
xposure settings determined by the 
ware are applied to the Exposure 

ol.
f the changes to the exposure settings 
n the preview area.
HAdjusting images of 

pictures
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➮

➮

Adjust exposure
The scanning software automatically selects the 
optimal exposure settings for the output type applied 
to the image of a picture. However, if the original 
picture needs the brightness or contrast adjusted, you 
can use the Exposure Adjustment tool to increase or 
decrease:
■ highlights (see page 78)
■ shadows (see page 79)
■ midtones (gamma) (see page 80)
■ clipping of white and black pixels (see page 83)
■ output levels for white and black pixels (see page 85)

The exposure settings you select will be applied to the 
final scan.

You can also use the Exposure Adjustment tool to:
■ view the distribution of pixels (see page 81)
■ read the RGB values of the pixels in the image (see 

page 81).

The Exposure Adjustment tool is active for the color and 
grayscale output types.

Using the Expo

1 From the Tools 

The Exposure Ad

2 Refer to the foll
Adjustment too

■ Changing highlig

■ Changing shadow

■ Changing midton

■ Checking for clip

■ Setting pixel out

Applying the d
■ Click the Auto b

• The optimal e
scanning soft
Adjustment to

• The results o
can be seen i
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mber in the Highlights field, then 
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 spin button next to the Highlights 

Highlights set at 122t at 215
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➮
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Changing highlights

The Highlights control in the Exposure Adjustment tool 
lets you select the lightest printable value in the image. 
This gives coverage to areas that would otherwise 
remain the color of the paper. You may change 
highlights to:
■ lighter to bring out details
■ darker to minimize details

The range for the number in the Highlights field is set in 
the Preference Controls tab (see page 53).

Bringing out det

To bring out deta
decrease the num
■ Click on the left

– or –
■ type a lower nu

press Tab or En
– or –

■ click the DOWN
field.

slider

field

DOWN spin button

UP spin button

Highlights

control

You can change the amount of tonal resolution 
per color available for correction in the Exposure 

Adjustment tool (see page 53).

T I P
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ils in the dark areas of the image, 
ber in the Shadows field:
 side of the slider,

mber in the Shadows field, then press 

 spin button next to the Shadows field.

e change to Shadows can be seen in 
a.

Shadows set at 3t at 10
HAdjusting images of 

pictures
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➮
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Changing shadows

The Shadows control in the Exposure Adjustment tool 
lets you select the darkest printable value in the image. 
This allows you to bring out detail in areas that would 
otherwise become black. You may make dark parts of 
images:
■ lighter to bring out details
■ darker to minimize details

The range for the number in the Shadows field is set in 
the Preference Controls tab (see page 53).

Bringing out det

To bring out deta
decrease the num
■ Click on the left

– or –
■ type a lower nu

Tab or Enter,
– or –

■ click the DOWN

The result of th
the preview are

Shadows

slider

field

DOWN spin button

UP spin button

control

A Shadows value close to or at zero 
generally produces an image with better 
shadow detail.

T I P

Shadows se



+$%&

4 P PrecisionScan Pro User’s Guide 80

 image

age overall, increase the number in 
:
t side of the slider,

umber in the Midtones field, then 
ter,

n button next to the Midtones field.

e change to Midtones can be seen in 
a.

Midtones set at 3.0t at 2.2
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➮
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Changing midtones (brightness)

The Midtones control in the Exposure Adjustment tool 
lets you brighten or darken an image overall by 
changing the gamma value.

The range for the number in the Midtones field is 1.0 to 
4.0.

Brightening the

To brighten the im
the Midtones field
■ Click on the righ

– or –
■ type a higher n

press Tab or En
– or –

■ click the UP spi

The result of th
the preview areMidtones

slider

field

DOWN spin button

UP spin button

control

If you will be sharing the image with others, the 
Midtones value 2.2 is recommended, since the 
brightness of monitors varies.

T I P

Midtones se
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 settings for Highlights and 
s not change the graph in the 

 selection area changes the graph 
am.
 setting is not represented in the 

the histogram represents pixel 
 the input image, not in the image 

utput.

der the eyedropper pointer
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Pixel distribution histogram

The histogram in the Exposure Adjustment tool is a 
graph of the distribution of pixels in the selection area. 
The vertical lines in the histogram show the current 
settings for Shadows and Highlights.
➊The magenta line in the histogram represents the 

current setting for Shadows, the darkest areas in the 
image.

➋The red line in the histogram represents the current 
setting for Highlights, the lightest areas in the image.

➌The turquoise line appears in the histogram when 
either eyedropper pointer is positioned over the 
image. It shows you where the pixels at that place in 
the image occur in the histogram.

■ Changing the
Shadows doe
histogram.

■ Changing the
in the histogr

■ The Midtones
histogram.

■ The graph in 
distribution in
that will be o

T I P

Shadows Highlights

➊ ➋

Pixels un
➌
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er over the image.
es and pixel color appear in the RGB 

 line appears in the histogram.

eyedropper button again.
r dims.

eturns to normal.

ile the eyedropper pointer is over 
ss you want to change the setting 
 Shadows.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

RGB Meter

You can view the RGB values and pixel color for any 
spot in a color or grayscale image with the RGB Meter in 
the Exposure Adjustment tool.

Using the RGB Meter

1 Click either eyedropper button in the Exposure 

Adjustment tool:

■ When you click , the pointer changes to this: .

■ When you click , the pointer changes to this: .

2 Move the point
• The RGB valu

Meter.
• The turquoise

3 Click the same 
• The RGB Mete

• The pointer r
➊ ➋

➊ RGB values 

➋ Pixel color

Do not click wh
the image unle
for Highlights or

T I P
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Appearance when
neither Exposure Alert

button is on

e when
Exposure Alert

turned on

Appearance when
the black Exposure Alert

button, is turned on
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Checking for clipping of pixels

The Exposure Alert buttons in the Exposure Adjustment 
tool warn you of areas of a color or grayscale image 
that contain no detail in the lightest and darkest areas 
of the image. The lightest area will print as the color of 
the paper, with no ink or toner, and therefore no detail. 
The darkest areas will print with the blackest color of 
ink or toner, saturating the area with the same color of 
black with no visible detail. 

The Exposure Alert buttons in the Exposure Adjustment 
tool are:
■  – for viewing white pixels that will be clipped in 

the final scan

■  – for viewing black pixels that will be clipped in 
the final scan

Appearanc
the white 
button, is 
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oving clipped dark areas

lack Exposure Alert button.

in the image that will print as pure 
hite in the preview area.
 control, click the DOWN spin button 
l the clipped pixels disappear from 

e change to Shadows can be seen in 
a.

lack Exposure Alert button again.

ert button turns off.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Viewing and removing clipped light areas

You can adjust the light or dark areas to add detail back 
to them.
1 Click , the white Exposure Alert button.

The light areas in the image that will print as pure 
white appear black in the preview area.

2 In the Highlights control, click the UP spin button 
repeatedly until the clipped pixels disappear from 
the image.
The result of the change to Highlights can be seen in 
the preview area.

3 Click , the white Exposure Alert button again.

The Exposure Alert button turns off.

Viewing and rem

1 Click , the b

The dark areas 
black appear w

2 In the Shadows

repeatedly unti
the image.
The result of th
the preview are

3 Click , the b

The Exposure Al
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t levels

vels control in the Exposure Adjustment 
resting effects in images of pictures.

e numbers in the White and Black 
e Preference Controls tab (see page 53).

t Levels checkbox in the Exposure 

l to select it.

lack output levels controls appear in 
justment tool.
e side of a slider, 

 number in the White or Black field, 
or Enter,

he DOWN spin button next to the 
ield.

 changes to Output Levels can be seen 
rea.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Setting pixel output levels

The Output Levels control in the Exposure Adjustment 
tool lets you create interesting effects for images of 
pictures.

When you change the White output level value to 0 and 
the Black output level value to 255, the colors in the 
image reverse.

Changing outpu

Use the Output Le

tool to create inte

The ranges for th
fields are set in th
1 Click the Outpu

Adjustment too

The White and B
the Exposure Ad

2 Click on the on

– or –

type a different
then press Tab 

– or –

click the UP or t
White or Black f

The result of the
in the preview a

Appearance with
White control = 255
Black control = 0

Appearance with
White control = 0
Black control = 255
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Appearance with
White control = 255
Black control = 0

5
0

Appearance with
White control = 0
Black control = 255
HAdjusting images of 

pictures
Book Contents Index

➮

➮

If you want to create an image to use as a backdrop for 
dark text on a light background, such as an overhead 
transparency, increase the Black output level value until 
the image is as faint as you like.

If you want to create an image to use as a backdrop for 
light text on a dark background, such as with color 
slides, decrease the White output level value until the 
image is as faint as you like.

Click the Auto button in the Exposure Adjustment 

tool to change all the exposure settings to the 
optimal exposure settings determined by the 
scanning software

T I P

Appearance with
White control = 25
Black control = 20
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r balance

el in the Color Adjustment tool to 
nce (hue). 

cator circle

has too much 
e the 
ward the 
posite color) 
l.

tor circle with 

iangle

e change to 
seen in the 

lor for photographs that are faded 
ch of one color.

Indicator circle in
the Color Wheel
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Adjust color
The scanning software automatically selects the 
optimal color settings for any color output type applied 
to the image. If the overall color in the original picture 
is out of balance, or the picture needs more or less 
color, you can use the Color Adjustment tool to increase 
or decrease:
■ color balance, or hue (see page 87)
■ color saturation (see page 88)

The Color Adjustment tool is active for these output 
types:
■ True Color

■ 256 Color Web Palette

■ 256 Color System Palette

■ 256 Color Optimized Palette

1 From the Tools menu, select Color Adjustment.

The Color Adjustment tool appears (see page 37).
2 Change the color balance or saturation as described 

below.

The color settings you select will be applied to the final 
scan.

Changing colo

Use the Color Whe

change color bala

Moving the indi

When the image 
of one color, mov
indicator circle to
opposite side (op
on the Color Whee

■ drag the indica
the mouse, or

■ click a color’s tr

The result of th
the hue can be 
preview area.

Adjust image co
or have too mu

T I P
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r saturation

e amount of color in the image with 
er control in the Color Adjustment tool. 
mber in the Saturation field, the more 
ill be in the image. A low number in 

d gives the image diluted colors.

 
turation 

hange to the saturation value can be 
w area.

mount of color

ber in the Saturation field to make 
e more vivid:
t side of the slider,

umber in the Saturation field, then 
ter,

n button next to the Saturation field.

mount of color

ber in the Saturation field to dilute the 
:

 side of the slider,

mber in the Saturation field, then 
ter,
HAdjusting images of 

pictures
Book Contents Index

➮

➮

To correct the excess red in the picture below, the 
indicator circle can be moved into the cyan area of the 
Color Wheel.

The hue of an image can be changed to create a 
different effect.

Changing colo

You can adjust th
the Saturation slid
The higher the nu
vivid the colors w
the Saturation fiel

The range for the
number in the Sa

field is 0 to 150.

The result of the c
seen in the previe

Increasing the a

Increase the num
colors in the imag
■ Click on the righ

– or –
■ type a higher n

press Tab or En
– or –

■ click the UP spi

Decreasing the a

Decrease the num
color in the image
■ Click on the left

– or –
■ type a lower nu

press Tab or En
– or –

moved
indicator circle

Very red Less red

moved
indicator circle

Original Special effect
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efault color settings
utton in the Color Adjustment tool.
olor settings determined by the 
ware are applied to the Color 

ol.
f the changes to the color settings can 
 preview area.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

■ click the DOWN spin button next to the Saturation 
field.

Applying the d
■ Click the Auto b

• The optimal c
scanning soft
Adjustment to

• The results o
be seen in the

Saturation set at 100

Saturation set at 150

Saturation set at 75
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tings for photographs

elines to set output resolution for 
 white photographs.

utput resolution setting when:
isplay the image on a monitor in a 

e is 256 Color Web Palette, 256 Color 

, 256 Color Optimized Palette, or 

utput resolution setting when:
rint the image on a 300 DPI printer
e is True Color, 256 Color Optimized 

yscale

utput resolution setting when:
rint the image on the HP PhotoSmart 
00 DPI printer
e is True Color, 256 Color Optimized 

yscale

e enlarging the photograph (use a 
tion if you scale the image to greater 

mages, higher resolution does not 
 quality, but does increase the 
s required to store the image.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Set output resolution
To keep file size small, shorten printing time, and use 
less memory, use the lowest possible output resolution 
setting for an image of a picture.

The output resolution for the image in the selection 
area is set in the Output Resolution tool.

The Output Resolution tool is active for these output 
types:
■ True Color

■ Grayscale

■ 256 Color Web Palette

■ 256 Color System Palette

■ 256 Color Optimized Palette

■ Black & White Bitmap (raster)

■ Spot Color

1 From the Tools menu, select Output Resolution.

The Output Resolution tool 
appears (see page 31).

2 Read the following sections 
before you change the value for 
output resolution in the Output Resolution tool.

The output resolution setting displayed in the Output 

Resolution tool will be applied to the final scan.

Resolution set

Follow these guid
color or black and
■ Use 75 as the o

• you plan to d
Web page

• the output typ
System Palette
Grayscale

■ Use 100 as the o
• you plan to p
• the output typ

Palette, or Gra

■ Use 200 as the o
• you plan to p

printer or a 6
• the output typ

Palette, or Gra

• you will not b
higher resolu

For Web page i
improve image
number of byte

T I P
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rint the image on a 1200 DPI printer
e is 256 Color Optimized Palette, 
lack & White Bitmap (raster)

efault resolution

utoResolution button in the Output 

esolution setting determined by the 
ware is applied to the Output 

l.
the change to the resolution setting 
n in the preview area.

 the resolution settings available in 
ool’s list box (see page 52).
HAdjusting images of 

pictures
Book Contents Index

➮

➮

than 100% of the original’s size)
■ Use 300 as the output resolution setting when:

• you plan to print the image on a 1200 DPI printer
• the output type is True Color, 256 Color Optimized 

Palette, or Grayscale

• you will not be enlarging the photograph (use a 
higher resolution if you scale the image to greater 
than 100% of the original’s size)

Resolution settings for drawings

Follow these guidelines for setting output resolution 
for images of color or black and white drawings.
■ Use 75 as the output resolution setting when:

• you plan to display the image on a monitor in a 
Web page

• the output type is 256 Color Web Palette, 256 Color 

System Palette, 256 Color Optimized Palette, 
Grayscale, or Black & White Bitmap (raster)

■ Use 300 as the output resolution setting when:
• you plan to print the image on a 300 DPI printer
• the output type is 256 Color Optimized Palette, 

Grayscale, or Black & White Bitmap (raster)

■ Use 600 as the output resolution setting when:
• you plan to print the image on the HP PhotoSmart 

printer or a 600 DPI printer
• the output type is 256 Color Optimized Palette, 

Grayscale, or Black & White Bitmap (raster)

■ Use 1200 as the output resolution setting when:

• you plan to p
• the output typ

Grayscale, or B

Applying the d

■ Click , the A
Resolution tool.
• The optimal r

scanning soft
Resolution too

• The result of 
cannot be see

You can change
the Resolution t

T I P
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aps

Image of a color
photograph with
the True Color

output type

 

tput

old
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Set threshold for black and white bitm
When you want to save a black and white image from a 
color or black and white photograph, you can often 
improve the result by changing the threshold for the 
division between black and white pixels.

The black and white threshold can be changed with the 
Black & White Threshold tool for an image that has the 
Black & White Bitmap (raster) output type. (See page 38 
for more about the Black & White Threshold tool.)

Applying the default threshold
■ Click the Auto button in the Black & White Threshold 

tool.
• The optimal black and white threshold setting 

determined by the scanning software is applied to 
the Black & White Threshold tool.

• The result of the change to the threshold setting 
can be seen in the preview area.

The Black & White

Bitmap (raster) ou
type and a black
and white thresh
of 15 applied



+$%&

4 P PrecisionScan Pro User’s Guide 93

 number in the threshold field is set in 
trols tab (see page 53).

Threshold 127

Black & White Bitmap (raster)

(the default for

49

this image)

e sharpen level to improve the 
 are changing a color or black and 

ph to a Black & White Bitmap (raster) 
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Changing the black and white threshold

To bring out details in an image with the Black & White 

Bitmap (raster) output type, decrease the number in the 
Black & White Threshold field:
1 Scan a picture.
2 From the Tools menu, select B & W Threshold.

The Black & White Threshold tool appears.
3 From the Output Type menu, select Black & White 

Bitmap (raster).

The image changes to black and white.
4 Decrease the value in the Black & White Threshold 

field:
■ click on the left side of the slider,

– or –
■ drag the slider to the left,

– or –
■ type a lower number in the Black & White Threshold 

field, then press Tab or Enter,
– or –

■ click the DOWN spin button next to the Black & White 
Threshold field.

The result of the change to the black and white 
threshold setting can be seen in the preview area.

The range for the
the Preference Con

Image with the 
output type

Threshold 

Try changing th
result when you
white photogra
image.

T I P
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 bitmaps
hannel from the Scan using channel list 
 & White Threshold tool:

 the red in colored line art or from a 
 on red or pink paper, choose the Red 

d components of each pixel in the 
apped to white and green and blue 

 each pixel will be mapped to black.
 the green in colored line art or from a 
 on green paper, choose the Green 

een components of each pixel in the 
apped to white and red and blue 

 each pixel will be mapped to black.
 the blue in colored line art or from a 
 on blue paper, choose the Blue 

ue components of each pixel in the 
apped to white and red and green 

 each pixel will be mapped to black.
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Set color channel for black and white
When you want to save a black and white bitmap of a 
picture that has been printed or photocopied on 
colored paper, or want to create a special effect, you 
can change the color channel used in the final scan.

Eliminating a color from the image

By changing the color channel setting in the Black & 

White Threshold tool you can eliminate red, green or 
blue from the image (see page 95).
1 Scan a picture.
2 From the Tools menu, select B & W Threshold.

The Black & White Threshold tool appears.
3 From the Output Type menu, select Black & White 

Bitmap (raster).

The image changes to black and white.
4 Decrease the value for the black and white threshold 

(see page 93).

5 Select a color c
box in the Black

■ To eliminate all
drawing printed
channel. The re
image will be m
components of

■ To eliminate all
drawing printed
channel. The gr
image will be m
components of

■ To eliminate all
drawing printed
channel. The bl
image will be m
components of

The Auto button in the Black & White Threshold tool 
does not reset the color channel.

T I P
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el and automatic 

el and higher 

channel in the Scan using channel list 
 & White Threshold tool converts 
 a ratio of 30% red, 59% green, and 
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Examples of changing color channels

Images of a color drawing changed to the Black & White 

Bitmap (raster) output type are shown with different 
color channels and black and white threshold settings 
applied in the Black & White Threshold tool.

Original with True Color output 
type

Black & White Bitmap (raster) output 
type applied with NTSC Gray color 
channel and 
automatic 
threshold (110)

Red color channel and 
automatic threshold (110)

Green color channel and 
automatic threshold (110)

Blue color chann
threshold (110)

Blue color chann
threshold (173)

The NTSC Gray 

box of the Black

color to gray at
11% blue.

T I P
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 Bitmap (raster) output type
HAdjusting images of 

pictures
Book Contents Index

➮

➮

Invert options
The Invert tool inverts, or reverses, the colors in an 
image. For example, the black and white areas are 
reversed in a black-and-white image. A color image will 
look like the negative of a color photo.

You can invert an image if you save to a raster output 
types, such as TIFF, GIF, or JPEG. Scans saved as B&W 
Vector, Text and Text with Images can not be inverted. 
This tool is probably most useful for B&W bitmaps and 
grayscale images.

When you turn on the Invert option, the inverted 
image is displayed in the preview area.

T I P

Black & White

Normal

Inverted
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ills the preview area.
ction area to include all the characters 
 final scan (see page 62).
al scan and the character conversion:
tination (see page 99), or
p to another program (see page 99), 

lipboard (see page 100), or
(see page 100).

d-drop or Copy and Paste,
 to a file.
Scanning text Book Contents Index

➮

➮

Scan and convert a block of text
A block of text can be selected in the preview image for 
conversion to editable, unformatted text.
1 Preview scan (page 57).
2 Create a selection area (see page 58).
3 From the Output Type menu, select Text as the output 

type.
4 To enlarge the view of the selection area:

• click , the Zoom button in the toolbar, or
• from the Scan menu, choose Zoom.

The scanner scans the selection area and the 

selection area f
5 Adjust the sele

you want in the
6 To begin the fin

• scan to a des
• drag-and-dro

or
• Copy to the C
• Save to a file 

Original Zoomed imagePreview image Drag-an
with selection area or Save
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 to another program

ation program.
ment and view the page that will 
ge.
 software window, position the 
he selection area.

nges to .
ouse button and drag the image to its 
open document.

nges to .
use button.

he image is performed.

erted to editable text and placed in 
ent.

 the original in the same place on 
ss until the final scan of the image is 
Scanning text Book Contents Index

➮

➮

Scan to a destination

Select this option to scan to:
■ A blank page in an application (i.e., Microsoft Word)
■ An opened document in an application (this option is 

not available with all applications)
■ A document management application
■ A web page creation application
■ A print or fax modem application

Drag-and-drop

1 Start the destin
2 Open the docu

receive the ima
3 In the scanning

pointer inside t

The pointer cha
4 Press the left m

position in the 

The pointer cha
5 Release the mo

A final scan of t

The text is conv
the open docum

■ Always Zoom scan a selection area you want to 
convert to text, then adjust the position and size 
of the selection area to be sure it contains all the 
characters you want to convert.

■ The text in the selection area is displayed at a low 
resolution and may not appear readable, even 
after a Zoom scan. 

■ During the final scan when you drag-and-drop, 
copy, or save the selection area, the text will be 
scanned at a higher resolution before it is 
converted to editable text.

S e l e c t i n g  T e x t

Be sure to keep
the scanner gla
completed.

T I P
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ave As... button in the toolbar, or
enu, select Save As..., or

log box appears.

mat choice in the Save as type list box 
.
ox, choose the directory where you 
e text file.
 box, type a name for the text file.

he text is performed.

erted to editable text.

d to the file.
HScanning text Book Contents Index

➮

➮

Copy to the Clipboard

1 Click , the Copy button in the toolbar, or
from the Edit menu select Copy, or
or press Ctrl+C.

A final scan of the image is performed.

The text is converted to editable text.

A copy of the text is placed in the Clipboard.
2 To paste the text in another program’s open 

document:
• Start the destination program.
• Open the document and view the page that will 

receive the text.
• Position the pointer where you want to place the 

text, then click.
• From the program’s Edit menu, choose Paste, or 

press Ctrl+V.

The text appears where you pasted it.

Save to a file

1 Click , the S
from the Scan m
press Ctrl+S.

The Save As dia

The only file for
is Text File (.txt)

2 In the Save in b
want to save th

3 In the File name

4 Click Save.

A final scan of t

The text is conv

The text is save
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ox, choose the directory where you 
e file.
 box, type a name for the file.

he entire area of the scanner glass is 

erted to editable text.

ages are saved to the .rtf file.
ile, open it in a program that can 
xt format files.

file opened in
her program
HScanning text Book Contents Index

➮

➮

Scan a whole page
A entire page of text, or text and pictures, can be saved 
to a PDF file, rich text format (.rtf), or HTML file that 
contains editable, formatted text and images.
1 Preview scan (page 57). 

It is not necessary to create a selection area or 
choose an output type.

2 From the Edit menu, choose Select All.
3 From the Output Type menu, select Text & Image.
4 From the Scan menu, select Save As. The Save As 

dialog box appears.

The only file format choices in the Save as type list 
box are PDF (.pdf), Rich Text Format (.rtf), and HTML.

5 In the Save in b
want to save th

6 In the File name

7 Click Save.

A final scan of t
performed.

The text is conv

The text and im
8 To use the .rtf f

interpret rich te

Original Preview image
with selection area

RTF 
anot
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 use the image

ge

tination

p to another program

p to the Desktop

lipboard
6
➮

➮

Saving sca
images

103 How you can

104 Print the ima

105 Scan to a des

106 Drag-and-dro

107 Drag-and-dro

108 Copy to the C

109 Save to a file
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 text, you can convert it to editable 

matted, editable text, see page 98.
atted, editable text, see page 101.
HSaving scanned images Book Contents Index

➮

➮

How you can use the image
When you have scanned a picture and are satisfied 
with the image in the selection area, there are several 
ways to use the image.
■ Print the image from the scanning software (see 

page 104).

Printing the image from the scanning software 
results in a hardcopy of the image, but does not save 
it to the hard disk.

■ Make the image permanent by placing it directly 
from the scanning software into another program. 
When you save the document you placed the image 
in, the image is saved with the document.

You can place the image directly into another 
program using:
• scan to a destination (see page 105)
• drag-and-drop (see page 106)
• copy and paste (see page 108)
• TWAIN (see page 11)

■ Make the image permanent by saving it to a file. 

An image file can be created using:
• drag-and-drop to the Desktop (see page 107)
• the Save As... command (see page 109)

When scanning
text.
■ To save unfor
■ To save form

T I P
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 area has been drawn, the entire 
anner glass is printed.
ep the original in the same place on 
lass until the final scan of the image 
.
press the copy button on the 
canner to send a scanned image to 
HSaving scanned images Book Contents Index

➮

➮

Print the image

1 Click , the Print button in the toolbar, or 
from the Scan menu, select Print,
or, press Ctrl+P.

The Print dialog box appears.
2 Fill out the options in the Print dialog box.
3 Click OK.

A final scan of the image is performed.

The image is sent to the printer.

When you print a copy of the image in the selection 
area you will be able to see the size and quality of 
the printed image.

Use the Print command to send a copy of the image 
to a printer. 

The Print command is unavailable for vector line 
art, text, and text & image Output Types.

N O T E

■ If no selection
area of the sc

■ Be sure to ke
the scanner g
is completed

■ You can also 
front of the s
your printer.

T I P
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HSaving scanned images Book Contents Index

➮

➮

Scan to a destination
Select this option to scan to:
■ A blank page in an application (i.e., Microsoft Word)
■ An opened document in an application (this option is 

not available with all applications)
■ A document management application
■ A web page creation application
■ A print or fax modem application
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 the original in the same place on 
ss until the final scan of the image is 
HSaving scanned images Book Contents Index

➮

➮

Drag-and-drop to another program

1 Start the destination program.
2 Open the document and view the page that will 

receive the image.
3 In the scanning software window, position the 

pointer inside the selection area.

The pointer changes to .
4 Press the left mouse button and drag the image to its 

position in the open document.

The pointer changes to .

(If the pointer changes to , the destination 
program does not accept drag-and-drop.)

5 Release the mouse button.

A final scan of the image is performed.

The image appears in the destination program.

The image in the selection area can be dragged and 
dropped into another program that supports drag-
and-drop. 

After the image is dropped into the destination 
program, the image becomes part of the document 
file.

Be sure to keep
the scanner gla
completed.

T I P
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ep the original in the same place on 
lass until the final scan of the image 
.
ning Internet Explorer, only one 
med Scan.bmp can exist in a folder.
can.bmp file with a name that 

 image is in the file.
HSaving scanned images Book Contents Index

➮

➮

Drag-and-drop to the Desktop

1 In the scanning software window, position the 
pointer inside the selection area.

The pointer changes to .
2 Hold the Ctrl key down, press the left mouse button, 

then drag the selection area to the Desktop or to a 
folder in the Windows Explorer.

The pointer changes to .

3 Release the mouse button.

A final scan of the image is performed.

A bitmap file named Scan.bmp is created on the 
Desktop or in the folder in the Windows Explorer.

You can create a bitmap file of the image in 
the selection area by dragging the selection 
area to the Desktop or to a folder in the 
Windows Explorer. 

The file name for each new bitmap file after 
the first one created this way includes a 
number in parentheses.

■ Be sure to ke
the scanner g
is completed

■ If you are run
bitmap file na

■ Rename the S
reflects what

T I P
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age

ation program.
ment and view the page that will 
ge.
inter where you want to place the 
ck.
am’s Edit menu, choose Paste, or 

ears where you pasted it.
HSaving scanned images Book Contents Index

➮

➮

Copy to the Clipboard

Copying the image

1 Create a selection area (see page 58).

2 Click , the Copy button in the toolbar, or
from the Edit menu select Copy, or
or press Ctrl+C.

A final scan of the image is performed.

A copy of the image is placed in the Clipboard.

Pasting the im

1 Start the destin
2 Open the docu

receive the ima
3 Position the po

image, then cli
4 From the progr

press Ctrl+V.

The image app

The image in the selection area can be copied to the 
Clipboard, then pasted into the destination program. 
After the image is pasted into the destination 
program, the image becomes part of the document 
file.

Be sure to keep the original in the same place on 
the scanner glass until the final scan of the image is 
completed.

T I P
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ntains a complete image plus several 
opies of that image. The advantage 
 format over other file formats is that 
m can automatically select the best 
articular job to make editing and 
rograms faster and easier.

ed file format suitable for an image 
on the Web or on multiple platforms. 
r GIF file as an interlaced GIF. 

r text and graphics that will be viewed 
e Web. When this format is selected 
 text, the text is converted to editable 
as HTML and the graphics are saved 
es. The HTML file format is available 
HSaving scanned images Book Contents Index

➮

➮

Save to a file

File formats

The scanning software can save images in several 
graphics file formats.

Bitmap Image (.bmp)

An image file format used by Microsoft Windows and 
many Windows programs. This is often a good choice 
because Windows itself and most Windows programs 
accept the .bmp file type.

FlashPix (.fpx)

A FlashPix file co
lower resolution c
of the FlashPix file
a software progra
resolution for a p
using images in p

GIF Image (.gif)

GIF is a compress
that will be used 
You can save you

HTML (.htm)

HTML is useful fo
on the World Wid
for an image and
text and is saved 
as GIF or JPEG fil

The image in the selection area can be saved to a file, 
then the image file can be inserted into another 
program’s document with an Insert File or Import File 
command.

You will need to know what file format to use when 
saving the file.

Not all output types can be saved in all file 
formats. Only the valid file formats for the output 
type applied to the image can be selected from 
the Save as type list box in the Save As dialog box.

T I P
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ormat is used for saving to a .txt file 

ea contains only text
 type is applied
xt converted to editable, unformatted, 

y-standard image file format. TIFF 
reated by scanners and are widely 
rams that work with photographs and 
IFF file is a bitmapped graphic (also 
phic) and can be any resolution. TIFF 
 used on multiple platforms.

d (.tif)

 files for images are smaller than the 
mages with the Black & White Bitmap 

e are compressed with PackBits 
other output types are compressed 
ssion.

ile (.wmf)

ndows Metafile file format is used for 
mages in Windows programs. The 
s available for drawings when the 
able (vector) output type is applied to a 
t contains a drawing.
HSaving scanned images Book Contents Index

➮

➮

through the Save As command.

JPEG Image (.jpg)

JPEG is a compressed file format for images. Its 
strengths are small file sizes and speed. The trade-off 
for these advantages, though, is reduced image quality. 
Since each time an image is compressed with JPEG it 
loses a little of the image data, avoid compressing a file 
with JPEG more than once. JPEG is an appropriate file 
format for an image that will be used on the Web or on 
multiple platforms.

You can save your JPEG file as a progressive JPEG. 
When used on a web page, a progressive JPEG is 
initially sent as just every other line, with the remaining 
lines sent immediately after. This allows a (somewhat 
blurry) image to display sooner. Most people prefer 
this.

PCX Image (.pcx)

The PCX file format is for images used in Windows 
programs such as PC Paintbrush and Paint.

PDF (.pdf)

PDF is a searchable format useful for text, photos, and 
drawings. Use Adobe Acrobat Reader to view PDF files.

Rich Text File (.rtf)

The Rich Text File file format is used with the Save As 

Whole Page... command to create an RTF file of a page 
that contains text or text and pictures. The formatting 
of text in an RTF file can usually be interpreted by other 

programs.

Text File (.txt)

The Text File file f
when: 
■ the selection ar
■ the Text output
■ you want the te

ASCII text

TIFF Image (.tif)

TIFF is an industr
files are usually c
accepted by prog
other images. A T
called a raster gra
image files can be

TIFF Compresse

Compressed TIFF
TIFF Image files. I
(raster) output typ
compression. All 
with LZW compre

Windows Metaf

The Microsoft Wi
scalable (vector) i
.wmf file format i
Black & White Scal

selection area tha
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ize

e size of an image file in the scanning 

tion
ue Color output type
ale of the image
mpressed file format (.gif, .jpg, or .tif 
HSaving scanned images Book Contents Index

➮

➮

Saving the file

1 Click , the Save As... button in the toolbar, or
from the Scan menu, select Save As..., or
press Ctrl+S.

The Save As dialog box appears.
2 In the Save in box, choose the directory where you 

want to save the file.
3 In the File name box, type a name for the image file.
4 From the Save as type list box, choose a file type.
5 Click Save.

A final scan of the image is performed.

The image is saved to the file.

The file name extension for the selected file type is 
automatically added to the file name.

Reducing file s

You can reduce th
software by:
■ reducing resolu
■ avoiding the Tr

■ reducing the sc
■ saving with a co

compressed)

Be sure to keep the original in the same 
place on the scanner glass until the final 
scan of the image is completed.

T I P
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➮

➮

The 35mm slide adapter
The HP ScanJet slide adapter can be used to scan 
35mm mounted slide photographs. 

Placing the slide and the adapter

1 Lift the scanner lid so that it stays up.
2 Place the adapter next to the top edge of the scanner 

glass so that the arrowhead on the adapter points to 
the arrowhead on the scanner bed.

3 Tip the adapter toward the scanner lid.
4 Turn the slide so the emulsion side is next to the 

scanner glass.
5 Orient the slide with the top of the picture directed to 

the top edge of the scanner glass.
6 Place the slide under the notched section of the 

adapter.
7 Lower the adapter onto the scanner glass.
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 the slide in the same place on 
ss until the final scan of the 
eted.

f the 
a

HScanning transparencies Book Contents Index

➮

➮

Scan the slide
1 Preview scan (page 57).
2 Create a selection area of the part of the image you 

want in the final scan (page 58).
3 Zoom scan (page 63).
4 Set the output dimensions (page 65).
5 If necessary, make adjustments to the image (see 

Chapter 4 Adjusting images of pictures page 72).
6 Save, copy, drag-and-drop, or print (see Chapter 6 

Saving scanned images page 102).

A Preview scan of the slide

Be sure to keep
the scanner gla
image is compl

T I P

A Zoom scan o
selection are
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nsparency.
 general transparencies up to 5 inches 
2.7 centimeters by 12.7 centimeters), 
sparency in the large cut-out in the 
 template.
HScanning transparencies Book Contents Index

➮

➮

Active Transparency Adapter
The Use Transparency Adapter tool lets you use the 
Active Transparency Adapter (XPA) to scan, instead of 
scanning from the scanner bed.
1 Plug the Active Transparency Adapter (XPA) connector 

into back of scanner.

2 Place the large template on the scanner bed.

3 Position the tra
• For scanning

by 5 inches (1
place the tran
middle of the
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e XPA over the transparency. Align it 
er cut-outs on the large template.

 the scanner (you may leave it up).
ransparency Adapter option in the HP 
are:
nScan Pro it’s under the Tools menu. 
nScan it’s under the Settings menu.
ually do.

ncy Adapter Tool on page 40 for more 
necting and using the Active XPA.
HScanning transparencies Book Contents Index

➮

➮

• For scanning 35mm Slides:

a Place the second, smaller template in the cut-out 
of the large template on the scanner glass.

b Place the 35mm slide in the cut-out in the middle 
of the small template.

4 Place the Activ
to fit in the corn

5 Close the lid on
6 Check the Use T

scanning softw
• In HP Precisio
• In HP Precisio

7 Scan as you us

See Use Transpare

details about con
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C
Clear Selection command 20

clip art, Black & White 
Scalable (vector) output 
type 21

Clipboard, copying an image 
to 108

color
automatic application 51

balance 37, 87

Color Wheel 87

eliminating red, green, or 
blue 94, 95

output types 21

output types, adjustments 
73

saturation 37, 87, 88

vivid 88
Book Contents

➮

➮

Index

quiring with TWAIN 11

tive Transparency Adapter 
XPA) 115

justments 73

and output type 73

black and white threshold 
92, 93, 95

color balance 87

color channel 94, 95

color saturation 87

exposure 36, 77

highlights 36, 77

hue 87

midtones 80

output levels 85

resolution 31, 90

shadows 36, 77

sharpening 75

automatic
color 51

exposure 51

output type 51

selection area 51

AutoResolution 31

B
backgrounds, creating 86

Best Quality
Scaling 49

Sharpening 49

bitmap file format 109

Black & White Bitmap 
(raster) output type 21

Black & White Scalable 
(vector) output type 21

Black & White Thresh
38, 39, 92, 93, 94, 95

control range prefe
53

black and white
adjustments 74

bitmap (raster) 74

color channel 94, 9
output types 74

scalable (vector) 74

black and white thres
93, 95

Blue color channel 95

.bmp 109

brightness 78, 79, 80

button, Scan
configuring 12

using 10, 57
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 101

110

09

Windows Metafile 110

final scan 30, 56

pictures 111

text 98

TWAIN 11

whole page 101

FlashPix file format 109

.fpx 109

fuzzy images 65

G
gamma, setting 77, 80

.gif 109

GIF file format 109

Grayscale output type 21

adjustments 74

Green color channel 95

H
Help

HP ScanJet Coach 42

menu 23

online manuals 43

Show Me 42

status bar 41

ToolTips 41

using 41

videos 42
Book Contents

➮

➮

lor Adjustment tool 37, 87

lor channel 94, 95

lor Wheel, using 37, 87

lored paper, minimizing 
ffect 94

mmands
in menus 19

in toolbar 24

ntext-sensitive pointers 
8, 29

ntrols tab in Preferences 
3

ntrols, resetting
Black & White Threshold 

38, 92

Color Adjustment 37

Exposure Adjustment 36, 
77

Output Resolution 31, 91

Sharpen Level 33, 76

py command 20, 24, 108

pying to the Clipboard 108

leting settings 46

tail, eliminating 83

tail, enhancing 83, 84

black and white 93

highlights 78

shadows 79

sharpening 75

dimensions 34, 67, 68

locking output 68

Dimensions tool 34, 65

displaying images 70, 71

docking a tool 30

document management 
application, scanning 16

drag-and-drop
pointers 28

to another program 106

to the Desktop 107

drawings
output types for 91

resolution 91

resolution for 32

E
Edit menu 20

8-bit readout (0-255) 53

eliminating
details 83

red, green, or blue 94, 95

e-mail, scanning 14

exposure
adjusting 36, 77

automatic application 51

defaults 77

Exposure Adjustmen
36, 77

control range prefe
53, 78

histogram 81

RGB Meter 82

eyedropper pointers 

F
fax, scanning 15

file
formats 109

saving image to 10

111

saving text to 100

saving whole page
file format

bitmap 109

FlashPix 109

GIF 109

HTML 109

JPEG 110

PCX 110

PDF 110

Rich Text File 110

Text File 110

TIFF 110

TIFF Compressed 
Windows bitmap 1
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choosing 69
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71

Output Type menu 21

P
.pcx 110

PCX file format 110

.pdf 110

PDF file format 110

photographs
output types for 69, 90

resolution 90

pictures
output types for 69

pixel value pointers 29

pixels
output levels 85

preferences 49

placing original 9
pointers 28, 29

Preferences 47

color adjustment 51

command 19

Controls tab 53

exposure adjustment 51

output type change 51

pixel depth 49
Book Contents

➮

➮

What’s This Help 41

hlights 36, 77, 78

togram
Black & White Threshold 

tool 38

Exposure Adjustment tool 
36, 81
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Help menu 23

info bar 26
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Output Type menu 21
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Preferences dialog box 47
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status bar 27

toolbar 24

Tools menu 22

View menu 20

window 18

 ScanJet Button Manager 
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 ScanJet Coach 42
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tm 109
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e 37, 87
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copying 108

drag-and-drop 106, 107

output dimensions 65

printing 104

resolution 31, 90

saving 107, 109

scaling 67
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using 103
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jagged images 65

JPEG file format 110

.jpg 110
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Load Settings command 19

loading settings 46
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Edit 20

Help 23

Output Type 21

Scan 19

Tools 22

View 20

midtones 36, 77, 80

monitors, 256 color 7
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online Help, using 41

online manuals 43

optimized palette 70

output dimensions 3
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output resolution 31,
Output Resolution to

adding or deleting
52

AutoResolution 31

output type
and adjustments 7
automatic applicat
changing 70
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automatic creation 51

creating 58

move pointer 28
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zooming 25, 63

Selection Area tab in 
Preferences 50

settings
deleting 46

loading 46

saving 45

shadows 36, 77, 79

Sharpen Level tool 33, 75

sharpening 33, 75

preferences 49

Show Me videos 42

size
output image 34, 65, 67
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slides
creating background for 86

scanning 114
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starting scanning software 
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eview image 10, 18
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preferences 52
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RTF file format 110
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Save Settings command 19

saving
settings 45

to a file 100, 101, 109, 111

scaling 34, 67

preferences 49

Scan button on scanner
configuring 12

using 10, 57

Scan menu 19

scan to a document 
management applic

scan to a fax 15
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scan to e-mail 14
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ScanJet Button Man
scanner

HP support 3
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scanner Document 
Management butto
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scanner Scan button

configuring 12

using 10, 57

Scanner tab in Prefer
48

scanning
35mm slides using

116

basic steps 56

general transparen
using XPA 115

starting scanning 
software 10, 11
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